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1. INTRODUCTION

1.1 Purpose and Scope

This document describes the methods utilized and procedures executed to perform Oracle Communications Policy
Management release 10.5, 11.5, 12.0, or 12.1.1 software upgrade to Policy Management release 12.1.2 with
georedundancy disabled.

e Upgrade of the PM&C server including TVOE Host is required, but not covered in this document.
NOTE: Not all Policy Management systems use a PM&C Server, so this is optional.

e  Upgrade of firmware may be required, but is not covered in this document.

e In-service Policy Management release 10.5, 11.5, 12.0, or 12.1.1 CMP, MRA servers and MPE servers.

The non-georedundant cluster scheme has two servers, active and standby that are co-located on a site.

1.2 References

Depending on the hardware platform on which your Policy Management software operates, you need some of the

following documents before you upgrade the Policy Management software. Collect these documents, and if necessary

perform the prerequisite procedures in them, before beginning an upgrade.

The following documents are available at the Oracle Help Center:
e E53018-01—Tekelec Platform TVOE 3.0 Software Upgrade Guide
o E54387-03—Tekelec Platform 5.7 and 6.0 Incremental Upgrade Guide
e E59721-01—Tekelec Platform HP Solutions Firmware Upgrade Pack, Release 2.2.8 Upgrade Guide
e E59722-01—Tekelec Platform HP Solutions Firmware Upgrade Pack, Release 2.2.8 Release Notes
e E64920-01—Tekelec Platform HP Solutions Firmware Upgrade Pack, Release 2.2.9, Upgrade Guide
o E64919-01—Tekelec Platform HP Solutions Firmware Upgrade Pack, Release 2.2.9, Release Notes
e E72398-02—Oracle Communications Policy Management Release Notes for Release 12.1.2
e E70153-01—Oracle Communications Bare Metal Installation Guide 12.1.x
e E54387-04—PM&C Incremental Upgrade, Release 5.7 and 6.0
e [E53486-01—Tekelec Platform 7.0.x Configuration Guide, part number
e E71647-01—Policy Management Troubleshooting Reference
e E71641-01—Policy Management Platform Configuration User's Guide
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1.3Acronyms

Acronym Definition

CMP Configuration Management Platform

DSR Diameter Signaling Router

GUI Graphical User Interface

IPM Initial product manufacture

LVM Logical Volume Manager

MPE Multimedia Policy Engine

MRA Multiprotocol Routing Agent (also known as the Policy Front End)

0Cs Online Charging System

00s Out of service

PCEF Policy Control Enforcement Function (GGSN, P-GW, DPI)

PCRF Policy and Charging Rules Function—OQOracle MPE

PM&C Platform Management and Configuration
A segment is a collection of HSGWs, P-GWSs, DSRs, MPEs and MRAs that provide the PCRF

Segment service. A single MPE/MRA cluster may b.e part of only one PCRF Segment. A CMP
manages all the MPE/MRAs at multiple sites. A CMP manages one or more PCRF
Segments.

TPD Tekelec Platform Distribution

TVOE Tekelec Virtualization Operating Environment

UE User Equipment

1.4 Software Release Numbering

7 of 106

PM&C: 6.0.1.0.0_60.21.0
TVOE: 3.0.2.0.0_86.28.0
Policy Management release 12.1.2.0.0 22.1.0

Firmware: Tekelec Platform HP Solutions Firmware Upgrade Pack 2.2.8 or higher
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2. UPGRADE OVERVIEW

This section lists the required materials and information needed to execute Policy Management release 12.1.2 software upgrades.

2.1Upgrade Status Values

Status Condition

OK All servers are up-to-date and no alarms are present.

Info No alarms are present, but a condition (such as out-of-date) is present that the operator
should be made aware of.

Minor At least one minor alarm is present.

Major At least one major alarm is present.

Offline The server cannot be reached.

Degraded At least one server in the cluster cannot be reached.

Critical At least one critical alarm is present.

Active The server is active.

Standby The server is in standby mode as part of normal operations.

Forced Standby The server is in standby mode because it has been placed into that state via direct
operator intervention or as part of the upgrade.

Offline The server cannot be reached.

Zombie The server is in a state where it cannot recover automatically and requires direct operator
intervention.

2.2Upgrade Path

This upgrade document supports the following upgrade path:
1. Policy Management 12.1.1 to 12.1.2

2. Policy Management 12.0.x to 12.1.2
3. Policy Management 11.5.x to 12.1.2
4

Policy Management 10.5.x to 12.1.2

2.3Upgrade Information

This procedure applies to pairs of Active and Standby servers. A pair of servers is referred to as the cluster. The cluster
involves two servers. The cluster types are CMP, MRA, or MPE. For a CMP cluster, the cluster status can be Primary
Site and Secondary Site.

A Policy Management deployment can consist of multiple clusters.
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2.3.1 Required Cluster Upgrade Sequence

Policy Server software upgrades are performed on a cluster by cluster basis at the local and remote sites within the same
maintenance window.

The following is the upgrade sequence, specific processes are documented by an Oracle provided Maintenance
Operation Procedure (MOP).

NOTE: TVOE, PM&C Server, and Firmware upgrades are not covered in this document, but may be necessary prior to
the Policy Management upgrade.

Upgrade PM&C Server at Site 1—Needed if version is older than what is listed in Section 1.5
Upgrade PM&C Server at Site 2—Needed if version is older than what is listed in Section 1.5
Firmware upgrade—If needed

Upgrade Primary CMP

o M 0w D oE

Upgrade Secondary CMP (If applicable)
6. Upgrade MPE and MRA (See note below)
NOTE: Up to 4 MPE and MRA clusters can be upgraded in parallel.

2.3.2 Policy Release Mixed-Version Operation and Limitation

The general expectation is that a system that is running in a mixed version configuration should support features, and
perform at a level of the previous version. Thus, the system that is running release 10.5, 11.5, 12.0, or 12.1.1 and release
12.1.2 mixed configuration would support the performance and capacity of release 10.5, 11.5, 12.0, or 12.1.1. The
mixed version PCRF configuration would support release 10.5, 11.5, 12.0, or 12.1.1 features.

Since the CMP is the first PCRF system component that is upgraded to the new version, the release 12.1.2 CMP will be
managing the previous release, and release 12.1.2 MRA and MPE servers. In this mixed version configuration release
12.1.2 CMP will not prevent an operator from configuring anything that you could configure in a previous release and
all configuration items from the previous release are still available. However, the configuration changes during the
upgrade of PCRF system are discouraged and have limited support. This is due to the number of permutations involved
in testing different mixed version configuration scenarios.

In the mixed version Policy Management configuration release 12.1.2 CMP has the following limitations while running
in a mixed version environment:

e New features must not be enabled until the upgrades of all servers managed by that CMP are completed. This
also applies to using policy rules that include new conditions and actions introduced in the release.

e Asa general guideline, policy rules should not be changed while running in a mixed version environment. If it
is necessary to make changes to the policy rules while running in a mixed version environment changes that do
not utilize new conditions and actions for the release could be installed, but should be jointly reviewed by the
customer and Oracle before deployment to verify that these policies indeed do not use new conditions or
actions.

e The support for configuration of MPE and MRA servers is limited to parameters that are available in the
previous version. Specifically, Network Elements can be added
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Table 1 Mixed-version configurations supported between release 10.5, 11.5,12.0, or 12.1.1 and release 12.1.2

Policy Management system
components on: CMPR 12.1.2 MRAR 12.1.2 MPER 12.1.2
CMP R10.5,11.5,12.0,0r 12.1.1 Yes No No
MRA R10.5, 11.5,12.0,0r12.1.1 Yes Yes Yes
MPE R10.5, 11.5,12.0,0r 12.1.1 Yes Yes Yes

NOTE: Replication between CMP and DR-CMP is automatically disabled during upgrade of CMP and DR-CMP from
release 10.5, 11.5, 12.0, or 12.1.1 to release 12.1.2. The replication is automatically enabled once both active CMP and
DR-CMP are upgraded to release 12.1.2.

2.4 Customer Impacts

The cluster upgrade proceeds by upgrading the standby server and then switching over from the Active to the Standby,
and upgrading the second server. The switchover of each MPE or MRA cluster has a small impact on traffic being
processed at that cluster.

2.5 Rollback/Backout

The full pre-upgrade server image is stored on the server during the upgrade, and can be restored in the event of a
problem during or after upgrade.

2.6 TPD Version

The Tekelec Product Distribution (TPD) version needed for this release is included in the Policy Application Software
Upgrade ISO, and TPD is upgraded to version 7.0.2 as part of this procedure.

In the case of an initial product manufacture (IPM) or clean install of a new server, the supported baseline TPD version
7.0.2 should have been installed prior to upgrading to Policy Management release 12.1.2.

2.7Server Hardware Platforms

The Policy Management release 12.1.2 software upgrade can be applied on any server that previously had Policy
Management release 10.5, 11.5, 12.0, or 12.1.1

2.8 Loading Application Software

For upgrade of server application software, the recommended method is to copy the application ISO images to the
servers using the scp or ftp command. If the system is HP c-Class using a PM&C Server, the application software
must also be loaded into the PM&C software management library to support new installs and FRU activities.

NOTE: PM&C is not used during the upgrade and backout procedures.

2.9 Required Materials and Remote Access

Policy 12.1.2 software ISO files and TPD software ISO

Policy 12.1.2 software Release Notes.

TVOE, PM&C upgrade/installation documentation, software I1SO files and TPD ISO (if applicable).
HP Solutions Pack Firmware Upgrade Pack 2.2.8 documentation and I1SO files (if applicable).

o > w D E

The capability to remotely login to the target server as admusr.

NOTE: The remote login can be done through SSH, local console, or iLO maintenance port. Ensure the
customer network firewall policy allows the required application and corresponding ports.

6. The capability to secure copy (scp) from the local workstation being used to perform this upgrade to the target
server, or otherwise be able to transfer binary files to the target server.
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7.
8.

29.1

User login IDs, passwords, IP addresses, and other administration information.

VPN access to your network is required if that is the only method for remote logging into the target servers. It
must be also possible to access the Policy Manager GUI, and the PM&C GUI.

Upgrade Media

The following list is the ISO image files required for the 12.1.2 Policy Management upgrade.

NOTE:

cmp-12.1.2.0.0_22.1.0-x86_64.is0
mpe-12.1.2.0.0_22.1.0-x86_64.is0
mpe-li-12.1.2.0.0_22.1.0-x86_64.is0

mra-12.1.2.0.0_22.1.0-x86_64.is0
You will need either the MPE or MPE-L.i ISO file for the upgrade. The file you use is based on your current

Policy Management setup.

29.2

Login User IDs and Passwords

You will need to confirm login information for key interfaces, and document the information using Table 2 on page 12.
NOTES:

It is assumed that the login information may be common across sites. If not, record the information for each
site.

Consider the sensitivity of the information recorded in this table. While all of the information in the table is
required to complete the upgrade, there may be security policies in place that prevent the actual recording of
this information in permanent form.
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Table 2 Login IDs, Passwords and Release Information

Item

Value

CMP servers

NOTE: 10.5 does not use admusr, instead use
the default root SSH login.

GUI Administrator Login User/Password:

admusr password:

MRA/MPE servers

admusr password:

Target iLO iLO Administrator Login User/Password:
Target OA OA Administrator Login User/Password:
PM&C server GUI Administrator Login User/Password:

admusr password:

Software Upgrade Target Release!

Target Release Number:

Policy 12.1.2 software ISO image filenames.

cmp-12.1.2.0.0_22.1.0-x86_64.iso

mpe-12.1.2.0.0_22.1.0-x86_64.iso
or
mpe-1i-12.1.2.0.0_22.1.0-x86_64.iso

mra-12.1.2.0.0_22.1.0-x86_64.iso

! The 1O image filenames should match those referenced in the Release Notes for the target release.

12 of 106
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3. THEORY OF OPERATION

3.1 Upgrade Manager Page

The Upgrade Manager represents a significant shift from previous upgrade pages. In the past it was up to the operator,
with assistance from a MOP, to know the correct sequence of server selects and menu selections. The new Upgrade
Manager takes a different approach. It determines the next course of action to either

1. Begin/continue upgrading a cluster
2. Begin/continue backing out a cluster.

IMPORTANT: There is an important point implicit in the list above: upgrade is now presented from a cluster
perspective, instead of a server perspective.

The shift in perspective has a number of ramifications, most noticeably it is no longer possible to select individual
servers or to bulk select a group of servers. In fact, in order to perform any operation, it is necessary to select a cluster
first.

Another major shift is that certain operations are performed automatically on behalf of the operator. These operations
are not even presented to the operator as an option. However, the operator can see what has been done via the upgrade
log.

P kil hdinh 1L LE00 P10

20 i B ¥

A 8 gt Sustsaiatily 46 Fati . TS T190 1S

Figure 1 Sample display of the Upgrade Manager page
For the most part, the items in the display are self explanatory. The following items are often used during the upgrade.

e Start Rollback/Start Upgrade buttons (upper left): If a cluster is selected and these buttons are disabled
(grey), it means that there is not an appropriate action to take at this time. However, if a button is not disabled
(white), then it means that there is a preferred action that can be taken to upgrade (or backout) the cluster.
Normally, upgrading a cluster is a well defined fixed procedure. However, in some cases there are a number of
valid sequences. Selecting the preferred step will cause the Upgrade Director to choose the default sequence.
Only use the Upgrade Manager to perform upgrades unless the instructions direct otherwise.

e Alarm Severity: This column is used to indicate if there are alarms associated with a server. If so, it displays
the severity of the most severe alarm here. It is important to explain the intent of this column. The intent is to
give a visual indication that the particular server is experiencing alarms. This is not a reason to panic: During
the upgrade it is expected that the servers raise alarms:

0 The CMP will raise alarms to indicate that it is initiating upgrade activity.
o Servers will report alarms to indicate that their mate servers are offline.

However, if alarms are asserted for a server, it is good practice to look at the alarms prior to initiating upgrade
activity on them.

e Up to Date: This column is used to indicate the state of the code on the server.
0 N—Server is running old code needs to be upgraded
0 Y—Server is running new code.

0 N/A—Upgrade is not appropriate and/or the server is in a bad state
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3.1.1 The Upgrade Log

Within the Upgrade Manager page, the operator can access the upgrade log. This will display attributes of the various
actions (manual and automatic) that have been performed on the selected cluster. It is important to note that this is NOT
the audit log. The audit log is meant to track what the operator has done. This log is meant to capture the sequence of
upgrade activity—whether it was initiated by an operator or automatically triggered.

E upgradeDirectorTicketsDialog.jsp - Google Chrome = |[E] -
[% 10.148.242.110/mi/pages/upgradeDirectorTicketsDialog.jsp?id=C2013&name=TestMPE
Upgrade Log
D Fitter Columns +
1D Pare... Action Name Start Time End Time Durat... | Scope Hostname Result Mode Description
B 0 Preflight Check 292015 9:21:36 292015 9:21:54 - 0:00:17 © Server  chris16 Success Manual User inttiated action: ...
7 & Initiate upgrade 2192015 9:21:54 2/9/2015 10:25:06 = 1:03:11  Server  chris16 Success Automatic  Automatic action initi...
8 & Modify the role/replication ... | 2/9/2015 9:21:54 2/%201592:21:58  0:00:04 © Cluster @ TestMPE Success Automatic © Automatic action for ..
9 & VWait for replication to sync... | 2/%/2015 10:25:06 2/%2015 10:25:15 : 0:00:09 : Server  chris16 Success Automatic | Automatic action wait. ..
10 0 Failover to new version 2972015 11:20:08 22015 11:20:08 © 0:00:00 @ Cluster : TestMPE Success Manual User initiated action: ...
11 0 Preflight Check 2192015 11:20:41 2/%2015 11:20:54 : 0:00:12 © Server  chris15 Success Manual User intiated action: ...
12 1 Initiate upgrade 2192015 11:20:54 /%2015 12:23:06 | 1:02:11 : Server  chris15 Success Automatic | Automatic actien initi....
13 11 Madify the role/replication ... @ 2/9/2015 11:20:54 2/9/2015 11:20:59 - 0:00:04 : Cluster = TestMPE Success Automatic  Automatic action for ...
14 11 Wait for replication te sync... | 292015 12:23:06 22015 12:23:46 | 0:00:40 @ Server  chris1s Success Automatic © Automatic action wait...
15 11 Modify the role/replication ... @ 2/%/2015 12:23:06 22015 12:23:10 : 0:00:04 : Cluster | TestMPE Success Automatic © Automatic action for ..

Figure 2 Upgrade Log

3.1.2 Optional Actions

It is possible to perform every step in the upgrade process by using the Upgrade and Backout buttons. When the
operator selects these buttons, the Upgrade Director will perform the next preferred action. However, there are times
that the operator may want to take a slightly different—but still legal—procedure. For example, the Upgrade Director
has a preferred order in which it will upgrade a cluster. However, if the operator wanted to deviate from that default
procedure—say to restrict upgrade to servers in a particular site—then they can use the optional actions menu. It is
important to note that this menu will ONLY be populated with legal/reasonable actions. Actions that are wrong or
inconsistent will not be displayed.

If the operator selects an optional action, they can go back to using the default/preferred at any time

3.1.3 The ISO Select

In the upper right hand corner, there is an item called Current 1SO. In some respects the term ISO is misleading. A
better description might be upgrade procedure. This item shows the upgrade procedure that is being used. In common
cases, this is going to be either:

e Astandard (full) upgrade to version XXX

e Anincremental upgrade to version XXX

o sle W

To start a new upgrade, they click on this item. The Upgrade Director will search for valid upgrade procedures. In order
to minimize confusion, these upgrade procedures are usually embedded within a CMP ISO. This way, the CMP ISO file
is always tightly tied to the corresponding upgrade procedure.
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When you select a new ISO, you are telling the Upgrade Director to abandon its current upgrade procedure in favor of a
brand new procedure.

3.1.4 Introducing Upgrade Director Behavior

The Upgrade Director is a component that tracks the state of the servers, cluster and system during an upgrade. From a
user perspective, the Upgrade Director is hidden. However, there are conventions/operating principles that have user
visible effects.

3.1.4.1 Alarm Philosophy

During an upgrade, the Upgrade Manager asserts (that is, generates) and displays alarms. An upgrade typically triggers
multiple minor, major, and critical alarms as servers are taken out of service, go into forced standby, or fail over. This is
normal and to be expected. Error! Reference source not found. shows an example of an upgrade in progress asserting
multiple transient alarms.

Note: Click on the active alarms summary, in the upper right corner of every CMP page, to display a list of current
active alarms.

Curres| B0 planderd-uoarade 420288 1210

Poliack  Conliimes Usarede Viem Uppede Ly OFler  Cobms v Advanced
Hars AT S L'.' L R Hik Frov s ats R ."F:.'-G‘r.'\- Bl It mbian
= L e smet Cluster [ Servels]
Gl TR L 6 e v wndbry 10E8 118 130308 3210 ) it upgrade Compieled Husreasiely 81 Jul 13, 2018 13 18 5%
[= "L N b wage e wid 108 120308 3310 i
= O et i Cluter (7 Sevifal
[= LR i P il e 118 13 o) il upgracs Compieted Suscenately 81 Ju 13, 2318 1416 12
CHEST0 i Wao v gty 5L 115 130308 5510 o i gt Compialind Suschaklely &1 Jul 15, 230 $45 12
) i Cluntar 1 Senssre]
WOF ST e Spare 1S 110 TEE_1.1.0 n's
WOF2.STTA N Shwndbr wid 116 LA 11 n'a :
0T 1-ETLA I ARt a4 118 MWEE 1108 n'a
[ WPE Chumter i1 Servers)
WFELSTER LT 00s A05E_19.0 EEEETEE rrtoie sopreie - e upgrade {Dapsed Tame: S00.31)
WFEZ5TEA, & Critical saiive 124288 T80 " indinde upgrade Compieted Successtely of Jul 15, 316 11641
WPEI-5TEA = Critieal }- Ziwndbey WhE1IE n'a
L) MRk Clumier 3 Servers|
BRAES-EMES L Spare ME6_110 WEH110 na
MR2.EMES N Handlry WLE 118 148 110 e

Figure 3 Upgrade in Progress Showing Transient Alarms

The Upgrade Manager clears alarms when appropriate, such as when server and cluster upgrades are complete. Table 3
lists transient alarms that the Upgrade Manager can assert during an upgrade.

Table 3 Transient Alarms Asserted During a Typical Upgrade

Alarm Severit Name
Number v
31227 Critical HA availability status failed
31283 Critical Lost Communication with server
70001 Critical QP_procmgr failed
70025 Critical QP Slave database is a different version than the master
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Nﬁl:::; r Severity Name
31233 Major HA Path Down
70004 Major QP Processes down for maintenance
31101 Minor DB replication to slave failure
31106 Minor DB merge to parent failure
31107 Minor DB merge from child failure
31114 Minor DB replication over SOAP has failed
31282 Minor HA Management Fault
70500 Minor System Mixed Version
70501 Minor Cluster Mixed Version
70502 Minor Cluster Replication Inhibited
70503 Minor Server Forced Standby
70507 Minor Upgrade in Progress

The Upgrade Manager will also assert an alarm if an unexpected error prevents it from continuing the upgrade. You
should review all active alarms after each upgrade step to ensure that the alarms are expected. Alarms are described in
the Troubleshooting Guide, Release 12.1.2, available at the Oracle Help Center.

3.1.4.2 General Upgrade Procedure

In general, the upgrade of a server goes through the following steps:

1. Preflight checks—Ilook for certain conditions which guarantee a failed upgrade. If such conditions are detected,
fail. There are two principles behind the preflight checks

a. ltis better to fail early in a recoverable way than to fail late in an unrecoverable way.

b. Preflight checks are VERY narrow to avoid a false positive and preventing the valid upgrade from
continuing.

2. The upgrade itself
3. Wait for replication to synchronize.
This procedure is in place so that it should not be necessary for an operator to login to the target server to verify
conditions. They should be able to comfortably stay on the Upgrade Manager page.
3.1.4.3 Upgrade Order
With a two server cluster, this is the upgrade order:
1. Upgrade the standby
2. Failover

3. Upgrade the remaining server.

3.1.4.4 Unreachable Servers

During the course of an upgrade, servers can go unreachable. This is expected and the Upgrade Manager tries to be
graceful about unreachable servers. However, if the CMP experiences a failover when another server is unreachable,
this runs into limits. The promoted Upgrade Director does not have the full history/context. It will wait until it can
contact the unreachable server before it will take action on the server.
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3.1.4.5 Reversing Directions

In general, it should be possible to reverse directions at any time. You should be able to upgrade a server in a cluster,
back it out, upgrade it, upgrade its mate, back that out, etc... In this sense, upgrade/backout should be fully reversible.
However, you will not be permitted to reverse direction if there is an ongoing action: You cannot kick off a backout of a
server if another server in the cluster is being upgraded. You have to wait for the upgrade to finish.

3.1.4.6 Mixed Version and Forced Standby

As a general rule, if a cluster is in mixed version, then every server that is NOT running the same version as the active
server needs to be in forced standby. This way, a simple failover does not cause a change in the version of code that is
providing service.

NOTE: Forced standby is managed by the Upgrade Director and requires no user action.

3.1.4.7 Failure Handling and Recovery
Failures fall into two categories:
e  Failures that the Upgrade Director is able to recover from.
o  Failures that the Upgrade Director cannot automatically recover from.

Any failure should generate an UPGRADE_OPERATION_FAILED alarm. In such cases, the operation can be
attempted again. Ideally, the operator/support would investigate the original failure before repeating. However, if the
server is in an indeterminate state, the server is declared a ZOMBIE and no further action can be taken on the server. It
will require direct action by support/engineering to repair.

For the current release, recovery or even deep failure diagnosis is not exposed in the GUI.
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4. UPGRADE PREPARATION

This section provides detailed procedures to prepare a system for upgrade execution. These procedures are executed
outside a maintenance window.

NOTE: If Veritas Netbackup is being used on the system, see the Maintenance Operation Procedure for pre and post
upgrade steps.

Upgrade TVOE PM&C Server at Site-1 (if applicable)
Upgrade TVOE PM&C Server at Site-2 (if applicable)

Upgrade Primary active CMP

Upgrade Secondary CMP (if applicable)

Overview of steps:

1.

2

3. Firmware (if applicable)

4.

5

6. Segment 1 Site-1:
a. Upgrade MPE clusters
b. Upgrade MRA clusters

7. Segment 2 Site-1:

a. Upgrade MPE clusters
b. Upgrade MRA clusters

4.1 Pre-requisites

The following procedure table verifies that all required prerequisite steps needed to be performed before the upgrade
procedure begins.

TVOE-PM&C and firmware will need to be upgraded prior to the upgrade to Policy Management release 12.1.2.
Firmware upgrade to FUP 2.2.8 will need to be executed prior to the upgrade to Policy Management release 12.1.2

Step Procedure Result
1 |:| Verify all required As listed in section 2.9, Required Materials and Remote Access, on page 10.
materials are
present
2 |:| Review Release Review Policy Management release 12.1.2 for the following information:
Notes
® Individual software components and versions included in target release
e New features included in target release
®  Issues (Oracle BUGs) resolved in target release
e  Known Issues with target release
e  Any further instructions that may be required to complete the software upgrade for the target
release
THIS PROCEDURE HAS BEEN COMPLETED
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4.2 TVOE and PM&C Server Upgrade
Policy Management release 12.1.2 requires PM&C Version 6.0 to support the IPM of TPD 7.0 on c-Class server.

PM&C can IPM TPD on a c-Class server if the server is introduced either for disaster recovery (DR) or when adding
new servers to an enclosure (for example, capacity expansion).

See the following documents to upgrade the TVOE and PM&C:

e E53018-02—Oracle Communications Platform Tekelec Virtualization Operating Environment (TVOE) 3.0
Software Upgrade Procedure

e  E54387-04—O0racle Communications Platform PM&C Incremental Upgrade

4.3Firmware Upgrade
See the following documents to upgrade the TVOE and PM&C.

1. E59721-01—Oracle Communications Tekelec Platform HP Solutions Firmware Upgrade Pack, Upgrade
Guide, Release 2.2.8

2. E59722—O0racle Communications Tekelec Platform HP Solutions Firmware Upgrade Pack Release Notes,
Release 2.2.8

3. ISO files
a. FW2 MISC-2.2.8.0.0_10.43.0.iso
b. FW2 SPP-2.2.8.0.0 10.43.0.is0

4.4 Plan and Track Upgrades

The upgrade procedures in this document are divided into the following three main sequential steps:
1. Prerequisite: TVOE and PM&C Server upgraded and FUP 2.2.8 deployed.
2. Upgrade CMP clusters
3. Upgrade MPE/MRA clusters

Table 4 can be completed first before performing the upgrade, to identify the clusters to be upgraded and plan the work.
It can also be used to track the completion of the upgrades, and assign work to different engineers.

NOTES:

e Policy changes or configuration changes should NOT be made while the system is in a mixed-version
operation.

e Time estimates are for upgrade procedure without backout procedure. Backout procedure time is typically the
same as, or less than the upgrade procedure.
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Table 4 Upgrade information

Step

Procedure

Result

Engineer

Time

1 [

Use the following
checklist to plan the
cluster upgrades for the
entire system.

Maintenance Windows are planned

Upgrade Site-1
TVOE/PM&C

Site Names and

3 hrs

Upgrade Site-1 and Site-
2 CMP clusters

Site Names and

3 hrs

Upgrade Site-1
MPE/MRA clusters for
Segment-1

NOTE: Maximum of 4
clusters performed in
parallel

Site Names

Cluster List:

2 hrs

Upgrade Site-1 clusters
for Segment-2

NOTE: Maximum of 4
clusters performed in
parallel

Site Names

Cluster List:

2 hrs

THIS PROCEDURE HAS BEEN COMPLETED
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4.5 Perform System Health Check

This procedure is to determine the health and status of the servers to be upgraded and must be executed at least once
within the time frame of 24 to 36 hours prior to the start of a maintenance window.

Step Procedure Result
1 |:| CMP GUI Access Open a browser to access the Primary CMP GUI on its VIP address and login to verify
access.
2 |:| View Active Alarms Identify the cause of any existing active alarms, and determine if these may have impact

on the upgrade. Export current alarms to save into a file.

IMPORTANT: Before starting any upgrade activity, ensure that all Active
Alarms are well understood and resolved.

3 |:| View KPI reports Verify that the system is running within expected parameters. Export current KPIs to save
into a file.
| |:| Confirm NTP servers 1. Validate the IP connectivity between the server and NTP servers by PING.
reachable from all the 2. Confirm that time is synchronized on each server with CLI shell command of
servers (CMP, MPEs and
MRAs) to be upgraded (140 il

NOTE: If the time across Confirm that date is correct on each server.

the servers is out of 4.  Check that BIOS clock is synced with the clock using the following CLI shell command:
synch, fix it first and re-
validate this step, before
starting the upgrade
procedures.

hwclock

THIS PROCEDURE HAS BEEN COMPLETED

4.6 Deploy Policy Upgrade Software

Software should be deployed to each Policy server /var/TKLC/upgrade directory, before the actual upgrade
activities. This will typically be done with utilities such as SCP, WGET or SFTP. Because of the large size of the
software 1SO files, sufficient time should be planned to accomplish this step. For Policy Management release 12.1.2,
each 1SO image size is about 1.0 Gigabytes.

4.6.1 Deploying Policy Upgrade Software to Servers

There are four possible software images in this upgrade (CMP, MPE, MPE-Li, and MRA). A single image must be
deployed to the /var/TKLC/upgrade directory of each server to be upgraded, where the image is the correct type for
that server. That is, the new CMP software image must be deployed to the CMP servers, the new MPE image deployed
to the MPE servers, the new MPE-Li image deployed to the MPE-L.i servers and the MRA image deployed to the MRA
servers.

IMPORTANT: If the deployed image type (CMP, MPE, MPE-LI, or MRA) does not match the existing installed
software type, the upgrade will fail. Example: An attempt to upgrade a CMP with a MPE software image will fail
during the upgrade action.

NOTE: To change a server from one application type to another, the server must first be cleaned of all application
software by an Install OS action via the PM&C GUI, and then the new application type installed. Or, if multiple images
are copied into the /var/TKLC/upgrade directory, the upgrade will fail.

4.6.2 Copy ISO Image Files to Management Server (PM&C)
NOTE: Not all Policy Management systems use a PM&C server, if that is the case, skip to the next section.

This procedure transfers the software upgrade ISO files to the PM&C servers at each site to be upgraded, and loads ISO
files into the PM&C software image repository. This is done as a placeholder for future use of the software.
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IMPORTANT: PM&C is not used for the upgrade activities. The purpose of this procedure is to be prepared for server
recovery activities in case a server needs to be re-installed with software.

NOTES:

e ISO file transfers to the target systems may require a significant amount of time depending on the number of
systems and the speed of the network. The ISO file transfers to the target systems should be performed prior to
and outside of the scheduled maintenance window. Schedule the required maintenance windows accordingly
before proceeding.

e Because the ISO images are large, the procedure includes instructions to check space available in the
/var/TKLC/upgrade directory before copying the ISO files to this directory. After the Add Image action on
the PM&C, the ISO images are registered in PM&C, and stored in the
/var/TKLC/smac/ image/repository directory which is very large.

Step Procedure Result

1 |:| PM&C GUI: Verify that there | 1. Log on to the PM&C Server GUI
are no release 12.1.2 I1SO
files on the server.

Software = Manage Software Images

2. Confirm that the release 12.1.2 ISO files do not already exist. If the files are
there, remove them.

2 |:| SSH to PM&C server as 1. Logon asadmusr to the PM&C server.

admusr 2. Change Target directory to /var/TKLC/upgrade and ensure there is at least of
3.0 GB free disk space available.

$cd /var/TKLC/upgrade
$df -h /var/TKLC

NOTE: There may be ISO files in the /var/TKLC/upgrade directory, they can be
removed to free up disk space or added to the PM&C repository.

3 |:| Copy release 12.1.2 ISO files | Transfer all release 12.1.2 I1SO files (CMP, MPE/MPE-Li, MRA) into directory
to the target directory in the | /var/TKLC/upgrade using one of the following methods:

PM&C server
®  SCP/WGET command in the following steps outline in this Procedure
e  USBdrive

NOTE: If the directory becomes full, you may have to use the scp command to
transfer one ISO file at a time. Verify that the ISO file is in the directory before adding
the next ISO file. You may also use the

/var/TKLC/smac/ image/ isoimages/home/smacftpusr directory which has
more available space.

a4 [_]| Checkthe checksum file 1. Transfer the md5sum. out file to the /var/camiant/tmp directory.
2. Use the concatenate command, cat, to see the value of the checksum.
EXAMPLE

[root@CMP-JB-126 tmp]# cat md5sum.out
ccaB84e669c8db680F3264a93fe83aab7/home/build/build/PLATFORM-
70/iso/cmp-12.1.2.X_X.X.X.1iS0 [root@CMP-JB-126 tmp]#

3. Verify that the checksum value is the same as the value in the md5sum.out file.
EXAMPLE

[root@CMP-JB-126 iso]# md5sum cmp-12.1.2.X_X.-X-X-iSO
cca84e669c8db680F3264a93fe83aab7 cmp-12.1.2.x_X.X.X.iso [root@CMP-
JB-126 iso]#
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Step

Procedure

Result

5

L]

PM&C GUI: Adding the new
release 12.1.2 I1SO files

Software = Manage Software Images

1.

2.

Click Add Image to select the ISO files that were transferred into PM&C server.

A Mgin bymy; Saftwary = Marapy Saftwar imeges

A D

A r—
#
Path:varTKLC/smac/imagefisoimages/home/smacfipusr/cmp-12.1.2.( =
CMe 12.1.2
Description
P
Add New Image

Click OK on the pop-up

PM&C GUI: Verify the new
ISO files are added
successfully

Software > Manage Software Images

The status of the image being added can be monitored using the Task Monitoring

menu with the screen display as the following:

Background Task Monitoring

Fie o

B R 30 § 34

L Targat Batay S Pnning Toms  Jaurt Tamg Progress
] e e i Deer g 171200 221000 84 ODUPRI™ (2 :1:;2“ Ly
NOTE: The added ISO files are now stored in directory
/var/TKLC/smac/ image/repository
THIS PROCEDURE HAS BEEN COMPLETED
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4.6.3 Distribute Application ISO Image Files to Servers

This procedure applies to all server types. It assumes that the ISO image files will be electronically copied to the sites to
be upgraded.

NOTE: ISO file transfers to the target systems may require a significant amount of time depending on the number of
systems and the speed of the network. The ISO file transfers to the target systems should be performed prior to and
outside of the scheduled maintenance window. Schedule the required maintenance windows accordingly before
proceeding.

The distribution can be done in one of the following ways:
e 4.6.3.1 Manual Distribution
e 4.6.3.2 PM&C Distribution

4.6.3.1 Manual Distribution

Step Procedure Result
1 |:| Transfer ISO files to Policy Transfer release 12.1.2 ISO files (CMP, MPE/MPE-Li, and MRA) into
server. /var/TKLC/upgrade directory on the respective server using one of the following
methods:

e  SCP/WGET command
e  USBdrive

If the images are on a server in the same network, scp the files using the CLI.

e  Copy CMP software ISO file to ONE of the other CMP servers:

$sudo scp cmp-12.1.2.0.0_22.1.0-x86_64.1s0
user@remote_host.com:/var/TKLC/upgrade/

e  Copy MPE software ISO to ONE of the other MPE servers:

$sudo scp mpe-12.1.2.0.0_22.1.0-x86_64.1s0
user@remote_host.com:/var/TKLC/upgrade/

®  Copy MPE-Li software ISO to ONE of the other MPE-Li servers:

$sudo scp mpe-1i-12.1.2.0.0_22.1.0-x86_64.1so0
user@remote_host.com:/var/TKLC/upgrade/

®  Copy MRA software ISO to ONE of the other MRA servers:

$sudo scp mra-12.1.2.0.0_22.1.0-x86_64.iso
user@remote_host.com:/var/TKLC/upgrade/

NOTE: After copying the ISO to one of the respective servers, the ISO Maintenance
will be used to upload to the rest of the servers.

THIS PROCEDURE HAS BEEN COMPLETED
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4.6.3.2 PM&C Distribution

The PM&C product is not used during Policy Management upgrade and backout procedures. However, if your topology
is supported by PM&C servers, you should add the Policy Management ISO images to the PM&C image repository to
support new installations and server field replacements.

Collect the following information and material beforehand:
e The URL of the PM&C server and the guiadmin password
e The Policy Management ISO files, loaded into the directory /var/TKLC/upgrade on the PM&C server
Note: You can instead add images from the following sources:
e Media mounted in the CD/DVD drive of the PM&C host
e USB media attached to the PM&C host
e External mounts (prefix the directory with extfile://)
e These local search paths:
o /var/TKLC/upgrade/
o /var/TKLC/smac/image/isoimages/home/smacftpusr/

NOTE: CD, DVD, and USB images mounted on the PM&C VM host must first be made accessible to the PM&C VM
guest. To do this, go to the Media tab of the PM&C View VM Guest page on the PM&C VM Management page.

The following procedure assumes the 1SO file is located in the directory /var/TKLC/upgrade on the PM&C server.

Step Procedure Result

1 |:| Log in to PM&C Open a browser, enter the URL of the PM&C server, and log in as guiadmin.

The PM&C Main Menu opens. For example:

B T e

s T L s ]

e
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Step Procedure Result
2 |:| Select the ISO image 1. Select Main Menu > Software > Manage Software Images
The Manage Software Images page opens. For example:
Muain M FOMEre < Manage Softwars Images
| i -
T L
_—,;II Ifl:-.l."I . T S : Frou
T mai B A FOrackilmasd el beitana
et b
2. Click Add Image (at the bottom of the page).The Manage Software Images [Add
Image] page opens. For example:
Main Menu: Software -> Manage Software Images [Add Image]
Images may be added from any ofthese sources:
« Oracle-provided media in the PM&C host's CD/DVD drive (Refer to Note)
+ LUSB media attached to the PM&C’s host (Refer to Note)
« External mounts. Prefix the directory with “extfileir.
s These local search paths:
o NarTKLC/upgrade/*iso
o NarTKLC/smacimagefisoimages/homelsm Fliso
Note: CD and USB images mounted on PM&C's WM host must first be made accessible to the PM&C VM guest To do this, go to the Media tab
of the PM&C guest's View VM Guest page in ¥M Management
Path: harTKLClupgrade/mpe-12.1.2.0.0_22 1.0-xB6_B4.iso A
Description:
Add New Image Cancel
Select the ISO file from the Path dropdown list and click Add New Image.
Tip: You can enter a description of the ISO file before adding it.
You are prompted: Click OK to remove the image from
/var/TKLC/upgrade directory after it is added to the
repository. Click Cancel to leave it there.
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Step

Procedure

Result

3 [_]| Move the ISO file to the
repository

Click OK to move the file (or Cancel to copy it).

The ISO file is loaded into the PM&C image repository in the background.

Tip: You can click the Tasks dropdown list to check the progress of the task.

When the upload is complete, the ISO file appears in the list. For example:

Main Menu: Software -> Manage Software Images
Image Name Type Architecture Description
cmp-12.1.1.0.0_14.1.0-x86_64 Upgrade *B6_B4 CMP 12.1.1.0.0
TPD.install-7.0.3.0 0_86 43 0-OracleLinux6 7-x86_64 Bootable x86_64
mpe-12.1.2.0.0_221.0-xB6_&4 Upgrade x86_64
Add Image
Copyright © 2010, 2016, Oracls and/or its sffilistas. All rights reserved.

m

4 |:| Verify that the image is no
longer in the directory

Enter the following command:

$ sudo Is /var/TKLC/upgrade
$

Load addition files

If you are loading multiple ISO files into the image repository, repeat steps 2—4 until

all files are loaded.

Remove media

When you finish, remove the CD/DVD media or unmount the USB device.

THIS PROCEDURE HAS BEEN COMPLETED
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4.6.4 Backups and Backup Locations

Perform the Backups prior to the Maintenance Window period.

Step Procedure Result
1 [_]| SSHCLI/iLO: Access the IMPORTANT: Server backups (each CMP, MPE/MPE-Li, and MRA server—
server to be backed up active and standby), and the system backup (from the active CMP), must be
NOTE: System Backup is collected and readily accessible for recovery operations.
do?\lnﬁon active CMP servers 1. Login into the active Primary CMP server.
2. Navigate to the following through platcfg utility.
$sudo su - platcfg
3. Policy Configuration>Backup and Restore—> server backup
Provide the ISO backup filename in default backup location path of:
/var/camiant/backup/local_archive/serverbackup/<filename.iso>
= P Ty EE e
4. Navigate to the following through platcfg utility.
$sudo su - platcfg
5. Policy Configuration>Backup and Restore—> system backup
Provide the ISO backup filename in default backup location path of:
/var/camiant/backup/local_archive/systembackup/<filename.tar.gz>
3et backup location |
The isc path:
28 of 106 E75412-01



Software

Upgrade Procedure

Step

Procedure

Result

2 [

SSH CLI/iLO: Verify the
backup ISO file

If default location is accepted in the previous step, change to the following directory
and verify the files.

$ cd /var/camiant/backup/local_archive/serverbackup

$ Is
<hostname>-mpe_12.1.2.0.0_22.1.0-serverbackup-2014<xx><XX><XXXX>.1S0
$ cd /var/camiant/backup/local_archive/serverbackup

$ Is
<hostname>-mra_12.1.2.0.0_22.1.0-serverbackup-2014<xx><XX><XXXX>.1S0
cd /var/camiant/backup/local_archive/serverbackup

$ Is
<hostname>-cmp_12.1.2.0.0_22.1.0-serverbackup-2014<xx><XX><XXXX>.1S0
cd /var/camiant/backup/local_archive/systembackup

$ Is

<hostname>-cmp_12.1.2.0.0_22.1.0-systembackup-
2014<xX><XX><XXXX>.tar.gz

Copy backup files.

1. Copy files to remote server or local workstation/laptop.
Example of a remote server copy.

$ sudo scp /var/camiant/backup/local_archive/systembackup/xx_tar.gz
<ip_address_of_backup_repository>

Example of a local workstation/laptop copy.

$sudo scp /var/camiant/backup/local_archive/serverbackup/xx_.iso
<ip_address_of_backup_repository>

2. Remove the backup ISO file from the TPD Sever.

$sudo rm <backup_filename.iso>

Identify backup location

Backup location is:

Instructions to access to backups are as follows:

THIS PROCEDURE HAS BEEN COMPLETED
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4.6.5 Changing Non-Default Root and admusr Passwords

4.6.5.1 Improve Password Security

The default password hash prior to Policy 12.0 is MD5. MD5 is now considered a weak hash that can be brute force
cracked in a reasonable amount of time. The best hash to use is SHA512. This is currently the strongest hash supported
on the Platform. Due to this change, during upgrade all non-default passwords are automatically expired. This will
cause issues during upgrade from pre-12.1.1to 12.1.2 and above. To prevent those issues, the following procedure has
been created.

4.6.5.2 Impact

After this procedure is run, the root and admusr password will be hashed with the strongest possible method, SHA512.

This procedure only addresses root and admusr passwords. Other users should also update their password to benefit
from the new hashing. If they are not changed prior to the upgrade to 12.1.2, they will be expired post upgrade.

IMPORTANT: The following procedure should be executed prior to the upgrade to 12.1.2 only if the root or admusr
passwords are non-default.

Order to perform this procedure on an In-Service Policy Management system:
1. Standby CMPs
2. Active CMPs
3. Standby MPES/MRAs
4. Active MPES/MRAS

Step Procedure Result
1 |:| Login to the Server ®  For an upgrade from 11.5/12.0/12.1.1, login as admusr and change to root using
(MRA/CMP/MPE) the following command:
$sudo su -

®  For an upgrade from 10.5, login as root.

2 |:| Check the password field of | Issue the following:

root and admusr #egrep "~(root]admusr)® /etc/shadow

EXAMPLE OUTPUT

root: $6$mErkKresA$83n5G8dR3CgBJjMEABi 6b4847EXusUnzTaWNJgEi347B._WhLblc
.Cga.nmYCdQYSNwkst1CtUBi . tBSwWujUd. :16825:0:99999:7: ::

admusr:$6$mUstAfa$gn2B8TsW1Zd7mgqD333999Xd6NZnAEgY 10QJ7qi4xufHSQp1s6A
5JIxhu8kjDT8d1gcYQR5Q1ZAtSN8OG. 7mkyq/:16825::::::

NOTES:
e |f the first two characters after the colon ( : ) is $6, then this procedure is not
needed on this server. Skip to the next section.

e  If the first two characters after the colon are not $6, then it is probably $1 (MD5)
and this procedure should be followed for this server. Continue on with step 4

30 of 106 E75412-01



Software Upgrade Procedure

Step Procedure Result
3 |:| Order to perform the Perform steps 5-15 on each server in the following order:
change

1. Standby CMP

2. Active CMP

3. Standby MPEs/MRAs
4. Active MPEs/MRAs

4 []| Loginto the Server e  For an upgrade from 11.5/12.0, login as admusr and change to root using the
(MRA/CMP/MPE) as admusr following command:
$sudo su

5 |:| Verify the system-auth Issue the following command:

revisions #rcstool co /etc/pam.d/system-auth

6 [_]| Modify the system-auth 5. Open the system-auth file.
file #vi /etc/pam.d/system-auth

Modify the file. Change the md5 value to shab12

®  Current Line:

password sufficient pam_unix.so md5 shadow nullok
try_first_pass use_authtok

e  Modified Line:

password sufficient pam_unix.so sha512 shadow nullok
try_first_pass use_authtok

7 |:| Save the file e  [f the file required changing:
#rcstool ci /etc/pam.d/system-auth

e |f the file already was configured:

#rcstool unco /etc/pam.d/system-auth
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Step Procedure Result

8 [_]| Checkout revisions for

i #rcstool co /etc/login.defs
login.defsfile

9 |:| Edit login.defs file Shadow password suite configuration

1. Open the login.defs file.
#vi /etc/login.defs
2. Change the encrypt method from md5 to shal2.
Current Line:
ENCRYPT_METHOD MD5
Modified Line:
ENCRYPT_METHOD SHA512
NOTE: The line to edit is near the bottom of the file
3. Comment out the following line if necessary.

MDS_CRYPT ENAB yes

10 [ || SavetheFile e  [f the file required changing

#rcstool ci /etc/login.defs

e |f the file already was configured

#rcstool unco /etc/login.defs

11 [ ]| Checkout revisions for the Checkout the file.
libuser.conf file

# rcstool co /etc/libuser.conf

12 |:| Edit the libuser.conffile | Open the libuser.conf file and change the crypt style from md5 to shal2
#vi /etc/libuser.conf

®  Current Line:
crypt_style = md5

®  Modified Line:
crypt_style = sha512

NOTE: The line to edit is close to the top of the file.

After setting the password, the passwords are now successfully encrypted and are
using SHA512 (the strongest hash algorithm).

13 [_]| SavetheFile e [fthe file required changing

#rcstool ci /etc/libuser.conf

e |[f the file already was configured

#rcstool unco /etc/libuser.conf
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Step Procedure Result
14 |:| Set the admusr and root e  For root user
passwords

#passwd root

®  For admusr user

#passwd admusr

NOTE: After setting the password, the passwords are now successfully encrypted and
are using SHA512 (the strongest hash algorithm).

15 |:| Verify Logout of the current session and then login using the new password credentials.

THIS PROCEDURE HAS BEEN COMPLETED
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5. SOFTWARE UPGRADE CAUTIONS

Before upgrade, users must perform the system health check section. This check ensures that the system to be upgraded is in an
upgrade-ready state. Performing the system health check determines which alarms are present in the system and if upgrade can
proceed with alarms.

*kkk WARN I NG *kkkk

If the server being upgraded is not in a Normal state, the server should be brought to the Normal state before the upgrade
process is started. [Normal state is generally determined by lack of alarms.]

*k*k*%k WARN I NG *kkk*k

Read the following notes on upgrade procedures:

Where possible, command response outputs are shown as accurately as possible. EXCEPTIONS are as follows:

Session banner information such as time and date.
System-specific configuration information such as hardware locations, IP addresses, and hostnames.

ANY information marked with “XXXX” or “YYYY”. Where appropriate, instructions are provided to determine what output
should be expected in place of “XXXX or YYYY”

Aesthetic differences unrelated to functionality such as browser attributes: window size, colors, toolbars, and button
layouts.

After completing each step and at each point where data is recorded from the screen, the technician performing the upgrade
must initial each step. A check box should be provided. For procedures which are executed multiple times, the check box can be
skipped, but the technician must initial each iteration the step is executed. The space on either side of the step number can be
used (margin on left side or column on right side).

Captured data is required for future support reference if Oracle Technical Services is not present during the upgrade. Any CLI
level windows should be logged.

34 of 106 E75412-01




Software Upgrade Procedure

6. UPGRADE CMP CLUSTERS (10.5T0O 12.1.2)
This procedure will upgrade the Site-1 CMP cluster first, and if needed, upgrade the Site-2 CMP.

NOTE: If you are using Veritas NetBackup there are additional steps to perform before starting this procedure. See the
Maintenance Operation Procedure (MOP) for the Netbackup.

6.1 Upgrade CMP Clusters Overview
1. Upgrade Primary CMP cluster
a. Use the CMP GUI—System Maintenance (10.5), to place Primary Standby CMP into Force-Standby
b. Use the CMP GUI—System Maintenance (10.5), to upgrade the Primary Force-Standby CMP server

c. Use the CMP GUI—System Maintenance (10.5), to perform Switch Force-Standby on the Primary CMP
cluster

d. Log back into the CMP GUI and upgrade the remaining Primary CMP Force-Standby server using the
12.1.2 Upgrade Manager

2. Upgrade Secondary CMP cluster (if applicable)
a. Usethe CMP GUI, Upgrade = Upgrade Manager and upgrade the CMP Secondary Site 2
b. Start upgrade
c. Continue upgrade—failover
d. Continue upgrade
This procedure should not be service affecting, but it is recommended to perform this in a Maintenance Window

It is assumed that the CMP servers may be deployed as 2 clusters, identified as Site-1 and Site-2 as displayed on the
CMP GUI. When deployed as such, one site is designated as the Primary Site (which is the site that is managing the
Policy system), and the other is as Secondary Site (this site is ready to become Primary Site, if needed).

If the System is deployed with only ONE CMP, then the upgrade of the Secondary CMP can be skipped.
Identify the CMP sites to be upgraded, and verify which site is the Primary site and which site is the Secondary site.

CMP Sites Georedundant Status Operator Site Name Site Designation from Topology Form
(Site-1 or Site-2)
Primary Site

Secondary Site
Note the Information on this CMP cluster:

Cluster Name

Server-A Hostname
Server-A IP Address

Server-A Status

Server-B Hostname

Server-B IP Address

Server-B Status
IMPORTANT:

e CMP servers MUST be upgraded first, before the MPE or MRA clusters
e Site-1 CMP MUST be upgraded to the new release first, before the Site-2 CMP(if applicable)
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6.1.1 Upgrade Primary CMP Cluster

Step Procedure

Result

1 [

CMP GUI: Verify alarm
status.

Navigate to System Wide Reports > Alarms—> Active Alarms

1. Confirm that any existing alarm is well understood and no impact to the upgrade
procedure.

2. Capture a screenshot and save it into a file for reference.

1

CMP GUI: Identify and
record the CMP clusters

Navigate to Platform Setting=>Topology Settings = All Clusters

[ESE——
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1. Note which cluster is the primary and which cluster is the secondary.

The Primary CMP is noted with a P in parenthesis and a Secondary CMP is noted with
an Sin parenthesis.

2. Save a screenshot for future reference.

CMP GUI Access into
Primary CMP Server—
Remove old ISO files
from servers.

Upgrade Manager - 1SO Maintenance

1. Select the servers that show any old ISO files.

2. Select the server cluster and select Operations=> Delete ISO to remove any older I1SO
files.

‘ Columns l‘ | Filters l‘ |

3. Click OK to continue and wait until the successful deletion message appears

Wait until the ISO Maintenance page is refreshes showing that the ISO column blank

CMP GUI: Distribute I1SO
files to CMP/MPE/MRA
servers

NOTE: This step
depends on the ISO
type. Distribute 1SO files

Upgrade Manager - 1SO Maintenance

1. (Optional but Preferred) Filter CMP/MPE/MRA servers

2. One application at a time, select one server type (MPE, MRA, or CMP) to be
upgraded.

NOTE: The ISO files for each application type must already be copied over to at least
one server. See 4.6.3 “Distribute Application ISO Image Files to Servers” on page 24.

accordingly.
3. Select Operations=>Upload I1SO
| Columns v | | Filters v | | Operations v |

Push Script
Delete IS0

4. Fill in the dialog with the following information:

Mode: Select SCP
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Step Procedure Result
ISO Server Hostname/IP: <IP_address_where_ISO_files_are_located>
User: root
Password: <root_password_for_the_server>
Source 1SO file full path: /var/TKLC/upgrade/
ke
——— .
L L=
5. Click Add.
When completed, the ISO column will be populated with the ISO filename and a
notification of [100%]
5 CMP GUI: Verify ISO file | Upgrade Manager = ISO Management

distribution to all the
servers

e  Verify that the release 12.1.2 ISO file of the correct type is shown for each server.

e  When completed, the ISO column is populated with the ISO file name and a
notification of [100%]

NOTE: For those servers where the ISO file was copied to from the local machine, there
will not be a 100% indicator. This indicator is only available when transferring ISO files
using the ISO management feature.

CMP GUI: Verify status
of CMP clusters

1. Navigate to Upgrade Manager - System Maintenance
2. Confirm the CMP clusters have the following:

- Active/Standby status

- Running release of 10.5 version

- Replication ON

- Release 12.1.2 ISO files copied to at least one of each server types
(CMP/MRA/MPE)—Meaning, a copy of the MPE ISO file is on one of the MPE
servers, an MRA ISO file is on one of the MRA servers and a copy of the CMP ISO
file is on one CMP server

37 of 106

E75412-01




Software

Upgrade Procedure

Step

Procedure

Result

7 [

SSH CLI Primary Active
CMP: exchange keys

Exchange keys to all servers from the Site 1 Active Primary CMP. Login as root user.

1. Login asroot.

2. Exchange the keys.

mount -o loop /var/TKLC/upgrade/cmp-12.1.2.0.0_22.1.0-x86_64.1s0
/mnt/upgrade/

cp /mnt/upgrade/upgrade/policyScripts/*.pl /opt/camiant/bin
cd /
umount /mnt/upgrade

gpSSHKeyProv.pl —-prov --user=root

NOTE: You are required to enter the PASSWORD for user root
3.  Verify that the Keys are exchanged successfully with all the server clusters.

$sudo qpSSHKeyProv.pl --check

Example
Connecting to root@mpe-1c (10.250.zz.zz) ...
Connecting to root@cmp-1b (10.250.XX.XX) ...
Connecting to root@mra-la (10.250.yy.y)
[13/16] Provisioning SSH keys on mra-1b (10.250.ww.w) ...
[14/16] Provisioning SSH keys on mra-la (10.250.yy.yy) -..
[15/16] Provisioning SSH keys on mpe-1c (10.250.zz.zz) ...

[16/16] Provisioning SSH keys on cmp-1b (10.250.XX.XX) ...

SSH keys are OK.
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Step

Procedure

Result

s [

CMP GUI: Push the
release 12.1.2 upgrade
scripts to all servers in
the segment topology

Upgrade Manager = System Maintenance

1. Select all the servers in the topology as shown.

2. Select Operations=>Push Scripts. (It is safe to run the push script multiple times as

needed)
5 - #
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3. Click OK to continue the operation.

Operation successful.

Push Script

CMP234-112 IRSSET== 777 QK
MPE224-115 IEZSET== 775 QK
MPE234-116 I SSE T 705 0K
MPE234-117 I SSETO= 777 OK
MPE234-126 IRSSETE TG 0K
MRA234-120 0ESSET== 700 OK
MRA234-1210ESSET== 770 0K
MRA234-143 0L SSE T 8R OK

Upgrade Command L]

NOTE: Give the push script a minute to complete

CMP GUI: Set Force
Standby mode on the
Standby CMP—Primary
cluster

Upgrade Manager 2 System Maintenance

1. Select the checkbox for the Standby CMP Server at the Primary Site
2. Click Operations—> Force Standby.

- B e B0 o e (TSR
-;. :—..r. ot it i 110 184 53 1 5ul,_a0 v
Fae o] Ol e J1MRE Bedy ol 3188305 el o o=
3. Click OK to confirm and continue with the operation.
The Standby CMP server state will be changed to Force Standby
10 |:| CMP GUI: Upgrade the Upgrade Manager = System Maintenance
F -Standby CMP
orce-standby . 1. Select the Force-Standby CMP Server at the Primary Site.
server at the primary
site 2. Select Operations—> Start Upgrade.
NOTE: This will take
. by
approximately 40 b Tl A | R L= ke | opicuiom | ot Py
minutes to complete. e e e sion i e —
ot O il Cele RIRIR  Few Sy o1 B b | = il

3. Click OK to continue with the operation.

In the Upgrade Operation column, it will show the Progress bar along with the upgrade

activities.
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Step Procedure

Result

Upgrade Gperation

Iniiate upgrade - Upgrading server (Elapsed Time: 0:0..

+ Inttiate upgrade Completed Successfully at Sep 18, 2015 14:10:18.

During the upgrade activities, the following alarms may be generated and considered
normal reporting events.

Expected Critical Alarms

31283 Lost Communication with server

Expected Major Alarms

31233 HA Path Down
70004 QP Processes down for maintenance
70021 QP slave database is unconnected to the master

Expected Minor Alarms

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure

Wait until the ‘upgrade was completed....” status message appears

Upgrade Status

Completed: backout was completed
24/2015 20:48:29 UTC"

Completed: uparade was completed
30/2015 13:49:01 UTC"

IMPORTANT: If there is other status message appeared other than the
‘..upgrade was completed...” message, stop here and contact Oracle Technical
Services to troubleshoot and determine if a rollback should be executed

11 [ ]| CMP GUI: Verify that
the upgrade completed
successfully

Upgrade Manager = System Maintenance

Successful upgrade status will show 12.1.2 in the Running Release and Upgrade Operation
columns.

NOTE: Expect the server state role is still shown as Force Standby, same as prior to the
upgrade.

IMPORTANT: Any Sync Broken indicator ( <=) signifies that the data replication
between the two servers of the cluster is not synced yet. Do not continue if there
is a Sync Broken indicator for the server that was upgraded.

12 |:| CMP GUI: Verify alarms

System Wide Reports = Active Alarms

Following expected Alarm(s) ID: 70025 QP Slave database is a different version than the
master is expected. The alarm will be cleared after the cluster is fully upgraded.
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Step Procedure

Result

13 [ ]| cMP GUI: Switch the
upgraded release 12.1.2
CMP server to Active

Upgrade Manager = System Maintenance

1. Select the checkbox for the CMP cluster to be switched—primary cluster only
2. Select Operations = Switch ForceStandby

3. Click on OK to continue with the operation and a successful message appears.

NOTE: The current CMP GUI browser connection is lost. If this is the primary CMP cluster,
you will have to log back into the CMP system as shown in the next step.

4. Close the browser and re-open.

14 |:| CMP GUI: Login to the
CMP server VIP

1. Close the current CMP GUI browser tab.
2. Open another browser tab using the same CMP VIP address.

The Policy Management release 12.1.2 CMP GUI login dialog should appear as shown—
login username and password credentials are the same as the pre-upgrade credentials.

ORACLE

15 [ ]| CMP GUI: Verify new
Policy Management
release

Navigate to Help>About. Verify the release number is displayed as 12.1.2.

12.1.2.0.0_22.1.0

Copyright (C) 2003, 2016 Oracle. All Rights Reserved.

16 |:| CMP GUI: Critical alarms

The following alarms are seen until the SQL Database matches the master (12.1.2)

e 70025 QP Slave database is a different version than the master

e 31101 Database replication to slave failure

These alarms are expected and will remain until all CMP servers are upgraded.

NOTE: The Upgrade Manager will show the same alarms.

17 [_] | CMP GUI: Verify the
Policy Management
release 12.1.2 CMP is

Upgrade-> Upgrade Manager

=5 b CoP Smes Chusler (7 Servers)

Active CUF280-132 i Mncs e 1058910 AZNO_22 10
ChF280-133 o il o ] i _Ti34 FOSE_1
As noted, the active CMP server is now running release 12.1.2 and the new interface for
Upgrade Director is now in effect.
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Step Procedure

Result

18 |:| Primary Active CMP:
ssh to primary active
CMP and copy iso to

/var/camiant/iso

1.

Logon to the primary active CMP as admusr and copy the 12.1.2 ISO file to the

/var/camiant/iso directory:

$sudo cp /var/TKLC/upgrade/cmp-12.1.2.iso /var/camiant/iso/

Verify the copy by using the following command:

$ Is /var/camiant/iso/

CMP GUI: Locate the
new 12.1.2 Upgrade
Manual

Upgrade - Upgrade Manager

1.

3.

Select the Current ISO. In this case it is labeled Install Kit.

pngsle Wi

This will open a dialog box with a description of the ISO file that was copied into the

/var/camiant/iso directory.

Highlight the ISO file and click the button located in the bottom right-hand corner of

the window.

Select 150%

o F i gl T

redmnd: 1213040 e camanihomg-17 17 80_22 # i amsaried wih & i

Sabec] slanditdapgrade- 11 0L F00_23.1.81%0

When the confirmation message appears, click OK.

Within a few seconds, the Up to Date column transition from Y (meaning up-to-date) or N
(meaning needs upgrade).

CME Sie | Cleilar (3 Sawars
TP 80132 [LE= ¥ Actn

MPTaD-T e T . -

CMP GUI: New alarms
introduced with 12.1.2

The Following minor alarms, along with the active critical alarm, will now be active.

Dec 15, 2015 09:58 AM EST 70025

Occurrence Severity = Alarm ID Text
Mar 12, 2015 09:22 AW EDT Minor 70501 The Cluster is running different versions of software
Mar 12, 2015 09:22 AW EDT Minor 70500 The system is running different versions of software
Occurrence Severity | Alarm ID Text

The MySQL slave has a different schema version than the master,
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21 [ ]

CMP GUI: Complete the
upgrade of the Primary
CMP cluster

NOTE: The remaining
CMP server upgrade will
take approximately 40
minutes to complete.

Upgrade = Upgrade Manager

1. Select the Primary Site 1 CMP cluster
2. Click Continue Upgrade.

S Kslhiel & Lol |Pgy il

[ M el Chailin (3 Serve ~\

3. Click OK on the pop-up message to continue the upgrade on the remaining server in
the CMP cluster

During the upgrade activities, the following alarms may be generated and considered
normal reporting events.
Expected Critical Alarms

31283 Lost Communication with server
70001 QP_procmgr failed
70025 QP Slave database is a different version than the master

Expected Major Alarms

31233 HA Path Down
70004 QP Processes down for maintenance

Expected Minor Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure

22 []

CMP GUI: Verify the
status of upgraded CMP
server.

Upgrade Manager = Upgrade Manager

Successful upgrade status will show the following for both servers in the Primary CMP
cluster:

e 12.1.2 inthe Running Release column for both server
e AYinthe Up to Date column
®  Active/Standby

During the upgrade activities, the following alarms may be generated and considered
normal reporting events.

Expected Critical Alarms

31283 Lost Communication with server

70001 QP_procmgr failed

70025 The MYSQL Slave has a different schema version than the master
Expected Major Alarms

31233 HA Path Down
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Step

Procedure

Result

70004 QP Processes down for maintenance

Expected Minor Alarms

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

Proceed to next
upgrade procedure

Verify the following information:

®  Primary Site-1 is running release 12.1.2
e  Secondary Site, if applicable, is on release 10.5
e All C Level Nodes will be on release 10.5

®  Proceed to the next procedure if there is a GR CMP to upgrade. If not, skip to section
10.

THIS PROCEDURE HAS BEEN COMPLETED

6.1.2 Upgrade Secondary CMP Cluster

Step

Procedure

Result

1

L]

CMP GUI: Verify the
status of the CMP
cluster

Upgrade = Upgrade Manager

®  Primary CMP is completely upgraded to 12.1.2

®  Secondary CMP cluster is on release 10.5

CMP GUI: Upgrade
Secondary CMP cluster

NOTE: This will take
approximately 30
minutes to complete.

Upgrade = Upgrade Manager

NOTE: The Filter button can be used to show only the CMP servers. Enter CMP in the
Name field.
[ _F ¢ RHFITIF]

P b LR Ml

-

1. Select the checkbox for the Secondary CMP Server cluster at Site-2
2. Click Continue Upgrade.

=

3. Click OK to confirm and continue with the operation.

The specific action taken will be determined by the Upgrade Manager and based on the
specific version change being performed.

This will continue to upgrade the standby server only in the CMP cluster
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The Upgrade Operation column shows a progress bar along with the upgrade activities.

Upgrade Operation

[Step 2/3] 0% Initiate upgrade - Upgrading server (Elapsed Time: 0:0..-

+) Inttiate upgrade Completed Successfully at Sep 18, 2015 14:10:18.

During the upgrade activities, the following alarms may be generated and considered
normal reporting events.

Expected Critical Alarms

31283 Lost Communication with server
70001 QP_procmgr failed
70025 QP Slave database is a different version than the master

Expected Major Alarms

70004 QP Processes down for maintenance

Expected Minor Database replication Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31282 HA Management Fault

LOG FILE from the GUI showing complete on the 1%t server on the secondary site.

3 |:| CMP GUI: Continue the Upgrade = Upgrade Manager
upgrade of the

Secondary CMP cluster 1. Select the checkbox for the Secondary CMP Server cluster at Site-2

2. Click Continue Upgrade. Notice the message ‘Failover to new version...”

Start Rollback Continue Upgrade

B |nName Failover to new version CMP Site1 Cluster (next) |

e JL WL EL ]

‘ = CMP Site1 Cluster (2 Servers)

3. Click OK to confirm and continue with the operation.

The specific action will take a minute to complete. Wait until the upgraded server is
active, as shown below.

4. Select the checkbox for the Secondary CMP Server cluster at Site-2

Click Continue Upgrade. When hovering over the button, the message will display
the next action, which is to initiate upgrading the remaining CMP hostname.
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Click OK to confirm and continue with the operation.

During the upgrade activities, the following alarms may be generated and considered
normal reporting events .

Expected Critical alarm

31283 Lost Communication with server
70001 QP_procmgr failed
70025 QP Slave database is a different version than the master

Expected Major Alarm

70004 QP Processes down for maintenance

Expected Minor Database replication Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31282 HA Management Fault

CMP GULI: Verify that
the upgrade completed
successfully

Upgrade = Upgrade Manager

Successful upgrade status will show 12.1.2 in the Running Release and Upgrade Operation

columns.

CMP GUI: Verify alarms

System Wide Reports > Alarms - Active Alarms

Following expected Minor alarm(s) ID:

70500 System Mixed Version

Procedure is complete.

Verify the following information:

All CMP clusters upgrades are complete and running release 12.1.2.
All MRA and MPE clusters are running release 10.5

The Policy Management system is running in mixed-version mode.

THIS PROCEDURE HAS BEEN COMPLETED
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7. UPGRADE CMP CLUSTERS (11.5T0O 12.1.2)
This procedure will upgrade the Site-1 CMP cluster first, and if needed, upgrade the Site-2 CMP cluster.

7.1Upgrade CMP Clusters Overview
1. Upgrade Primary CMP cluster:
a. Use the CMP GUI—System Maintenance (11.5), to place Primary Standby CMP into Force-Standby
b. Use the CMP GUI—System Maintenance (11.5), to upgrade the Primary Force-Standby CMP server

c. Use the CMP GUI—System Maintenance (11.5), to perform Switch Force-Standby on the Primary CMP
cluster

d. Log back into the CMP GUI and upgrade the remaining Primary CMP that is the Force-Standby server
using the 12.1.2 Upgrade Manager

2. Upgrade the Secondary CMP cluster (If applicable)
Use the CMP GUI, Upgrade = Upgrade Manager and upgrade the CMP Secondary Site 2
a. Start upgrade
b. Continue upgrade—failover
¢. Continue upgrade
This procedure should not be service affecting, but it is recommended to perform this in a Maintenance Window

It is assumed that the CMPs may be deployed as 2 georedundant clusters, identified as Site-1 and Site-2 as displayed on
the CMP GUI. When deployed as such, one site is designated as the Primary Site (which is the site that is managing the
Policy system), and the other is as Secondary Site (this site is ready to become Primary Site, if needed).

If the System is deployed with only ONE CMP, then the upgrade of the Secondary CMP can be skipped.
Identify the CMP sites to be upgraded, and verify which site is the Primary site and which site is the Secondary site:

CMP Sites Georedundant Status Operator Site Name Site Designation from Topology Form
(Site-1 or Site-2)
Primary Site

Secondary Site
Note the Information on this CMP cluster:

Cluster Name

Server-A Hostname
Server-A IP

Server-A Status

Server-B Hostname

Server-B IP Address

Server-B Status
IMPORTANT:

e CMP servers MUST be upgraded first, before the MPE or MRA clusters
e Site-1 CMP MUST be upgraded to the new release first, before the Site-2 CMP(if applicable)
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7.1.1 Upgrade Primary CMP Cluster

Step

Procedure

Result

1 [

CMP GUI: Verify alarm
status.

System Wide Reports > Alarms—> Active Alarms

1. Confirm that any existing alarm is well understood and no impact to the upgrade
procedure.

2. Capture a screenshot and save it into a file for reference.

1

CMP GUI: Identify and
record the CMP
cluster(s)

Navigate to Platform Setting=>Topology Settings = All Clusters

L )

Can T [
. Verw PEER

HO (st
ey [adetn

1. Note which cluster is the primary and which cluster is the secondary.

The Primary CMP is noted with a P in parenthesis and a Secondary CMP is noted with
an S in parenthesis.

2. Save a screenshot for future reference.

CMP GUI: Verify status
of CMP clusters

Upgrade Manager 2 System Maintenance
Confirm the CMP clusters have the following:

e  Active/Standby status
®  Running show of 11.5 version
e  Replication ON

®  Release 12.1.2 ISO files copied to at least one of each server types
(CMP/MRA/MPE)—Meaning, a copy of the MPE ISO file is on one of the MPE servers,
an MRA ISO file is on one of the MRA servers and a copy of the CMP ISO file is on one
CMP server

CMP GUI Access into
Primary CMP Server—
Remove old ISO files
from servers.

Upgrade Manager - 1SO Maintenance

1. Select the servers that show old ISO files.

2. Select the server cluster and select Operations—> Delete ISO for any of the older ISO
files in the list.

L »

3. Click OK to continue and wait until the successful deletion message appears

Wait until the ISO Maintenance page is refreshes showing that the ISO column blank
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Step Procedure Result
5 |:| CMP GUI: Distribute ISO | Upgrade Manager = 1SO Maintenance
files to CMP/MPE/MRA
sle(:\jeros / / 1. (Optional but Preferred) Filter CMP/MPE/MRA servers
) 2. One application at a time, select one server type (MPE, MRA, or CMP) to be
NOTE: This step upgraded.
depends on the ISO file . o .
. . NOTE: The ISO files for each application type must already be copied over to at least
type. Distribute ISO files L o . ”
. one server. See 4.6.3 “Distribute Application ISO Image Files to Servers” on page 24.
accordingly.
3. Select Operations 2 Upload ISO
| Columns v | | Filters - | | Operations v |
Push Script
Delete IS0
4. Fill in the dialog with the following information:
Mode: Select SCP
ISO Server Hostname/IP: <IP_address_where_ISO_files_are_located>
User: admusr
Password: <admusr_password_for_the_server>
Source ISO file full path: /var/TKLC/upgrade/
Howkr
o 180 e :
L [
5. Click Add.
When completed, the ISO column will be populated with the ISO filename and a
notification of [100%)]
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Step Procedure Result
6 |:| SSH CLI Primary Active 1. Exchange keys to all servers from the site 1 Active Primary CMP. Login as admusr
CMP: Exchange keys user.
$sudo mount -o loop /var/TKLC/upgrade/cmp-12.1.2.0.0_22.1.0-x86_64.1iso0
/mnt/upgrade/

$sudo cp /mnt/upgrade/upgrade/policyScripts/*.pl /opt/camiant/bin
$cd /

$sudo umount /mnt/upgrade

$sudo gpSSHKeyProv.pl --prov

NOTE: You are required to enter the PASSWORD for user admusr

2. Verify that the Keys are exchanged successfully with all the server clusters.

$sudo qpSSHKeyProv.pl --check
EXAMPLE

Connecting to admusr@mpe-1c (10.250.zz.zz) ...

Connecting to admusr@cmp-1b (10.250_.XX.XX) --.

Connecting to admusr@mra-la (10.250.yy.y)

[13/16] Provisioning SSH keys on mra-1b (10.250.ww.w) ...
[14/16] Provisioning SSH keys on mra-la (10.250.yy.yy) -..
[15/16] Provisioning SSH keys on mpe-1c (10.250.zz.zz) ...

[16/16] Provisioning SSH keys on cmp-1b (10.250.XX.XX) ...

SSH keys are OK.
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Step

Procedure

Result

7 [

CMP GUI: Push the
show 12.1.2 upgrade
scripts to all servers in
the segment topology

Upgrade Manager - 1SO Maintenance

1. Select all the servers in the topology as shown in the figure.
2. Select Operations=>Push Scripts.
NOTE: It is safe to run the push script multiple times as needed.

F—
meaa

3. Click OK to continue the operation.

Operation successful.

Upgrade Command -]

Push Script

CMP234-112 ILZSETFIEITT
MPE234-115 IRSSETIEITS
MPE224-116 ILZSE T2 70F OK
MPE234-117 ILZSE == 077 OK
MPE234-126 ILSSE T 706 0K
MRA234-120 IEESETZE T OK
MRA234-121 IESSE TS 00 0K
MRA234-1430ESSETm= 28R OK

0K
0K

NOTE: Give the push script a minute to complete

CMP GULI: Verify ISO file
distribution to all the
servers

Upgrade Manager -2 1SO Management

1. Verify that the show 12.1.2 ISO file of the correct type is shown for each server.

2. When completed, the ISO column is populated with the I1SO filename and a
notification of [100%)]

NOTE: For those servers the ISO file was copied to from the local machine, there will not
be a 100% indicator. This indicator is only available when transferring ISO files using the
ISO management feature.
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Step

Procedure

Result

s [

CMP GUI: Set Force
Standby mode on the
Standby CMP in the
Primary cluster

Upgrade Manager - System Maintenance

1. Select the checkbox for the Standby CMP Server at Primary Site

2. Click Operations=> Force Standby.

Bommemy
T w e Wan M
LT gl g Brwea
r—— ¥ gL
& "
#owt [=_g° f="J RMINN Bl ‘oo I LA 30 LIl e I.I.S-Eu_ﬂ‘ o

3. Click OK to confirm and continue with the operation.
The Standby CMP server state will be changed to Force Standby.

CMP GUI: Upgrade the
Force-Standby CMP
server at the primary
site

NOTE: This will take
approximately 40
minutes to complete.

Upgrade Manager 2 System Maintenance

1. Select the Force-Standby CMP Server at the Primary Site.
2. Select Operations—>Start Upgrade operation.

Sy | Sewhstis

fra— o Clamae (SRR s Sl om0 00 6H | o b KN

3. Click OK to continue with the operation.

The Upgrade Operation column shows a progress bar along with the upgrade activities.

Upgrade Gperation

Iniiate upgrade - Upgrading server (Elapsed Time: 0:0..

+ Inttiate upgrade Completed Successfully at Sep 18, 2015 14:10:18.

During the upgrade activities, the following alarms may be generated and considered
normal reporting events.

Expected Critical Alarm

31283 Lost Communication with server

Expected Major Alarm

31233 HA Path Down
70004 QP Processes down for maintenance
70021 QP slave database is unconnected to the master

Expected Minor Alarms

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure

Wait until ‘Completed: upgrade was completed...” appears in the Upgrade Status column

LT : tarrrrs Wlale £ _*'": Rrpis of e Lipng* e “slabn
- Ceraet oo v T
X 5 ] ] iiRE Corpema ki i e
e o Siw] Clastar SMIITRE Gy iy opeRlllO J21Eal 1 - H'EE Tkl A

IMPORTANT: If a status message other than the ‘...upgrade was completed...’
message, stop here and contact Oracle Technical Services to troubleshoot and
determine if a rollback should be executed.
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Step Procedure

Result

11 [ ]| CMP GUI: Verify that
the upgrade completed
successfully

Upgrade Manager - System Maintenance

Successful upgrade status will show 12.1.2 in the Running Release and Upgrade Operation
columns.

NOTE: Expect the server state role is still shown as Force Standby—same as prior to the
upgrade.

IMPORTANT Any Sync Broken indicator (<= )signifies that the data replication
between the two servers of the cluster is not synced yet. Do not continue if there
is a Sync Broken indicator on the server that was upgraded.

12 |:| CMP GUI: Verify alarms

System Wide Reports 2 Active Alarms

Alarm 70025, QP Slave database is a different version than the master, is expected. The
alarm will be cleared after the cluster is fully upgraded to the same release.

13 [_]| CMP GUI: Switch the
upgraded show 12.1.2
CMP server to Active

Upgrade Manager 2 System Maintenance

1. Select the checkbox for the CMP cluster to be switched—primary cluster only, and
2. Select Operations—>Switch ForceStandby.

! DwSniCuww O Sa e

3. Click OK to continue with the operation and a successful message appears.

NOTE: The current CMP GUI browser connection is lost. If this is the primary CMP cluster,
you will have to log back into the CMP system as shown in the next step.

4. Close the browser and re-open.

14 |:| CMP GUI: Login to the
CMP server VIP

Close the current CMP GUI browser tab and reopen another browser tab with the same
CMP VIP address.

The Policy Manager shows 12.1.2 CMP GUI login form opens. The username and password
credentials are the same as the pre-upgrade.

ORACLE

15 [ ]| CMP GUI: Verify new
Policy Manager version

Navigate to Help=>About. Verify the release number is displayed as 12.1.2.

12.1.2.0.0_22.1.0

Copyright (C) 2003, 2016 Oracle. All Rights Reserved.
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Step Procedure Result

16 [ || CMP GUI: Critical alarms | The following critical alarm will be seen until the SQL Database matches the master
(12.1.2):

70025 QP Slave database is a different version than the master
The following minor alarm will also be seen:

31101 Database replication to slave failure

These alarms are expected and will remain until all CMPs have been upgraded to the same
version.

NOTE: The Upgrade Manager will show the same alarms.

17 |:| CMP GULI: Verify that Upgrade-> Upgrade Manager
Policy Manager shows
12.1.2 CMP is Active

As noted, the active CMP server is now running release 12.1.2

18 |:| Primary Active CMP: 1. Logon to the primary active CMP as admusr and copy the 12.1.x ISO to the
ssh to primary active /var/camiant/iso directory:

CMP and _copy_lso to $sudo cp /var/TKLC/upgrade/cmp-12.1.x.iso /var/camiant/iso/
/var/camiant/iso

2. Verify the copy.

$ Is /var/camiant/iso/
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Step Procedure Result
19 |:| CMP GUI: Locate the Upgrade = Upgrade Manager
12.1.2U d
new perace 1. Select Current ISO—in this case it is labeled Install Kit.
Manual
g e W=
i

This will open a dialog box with a description of the ISO file that was copied into

/var/camiant/iso directory.
Highlight the ISO file and click the button located in the bottom right-hand corner of

the window.

Select 150s

Sabec] slanditdapgrade- 11 0LX00_23.1.81%0

3. Click OK to confirm and continue with the operation
Within a few seconds, the Up to Date column transitions from n/a to Y (meaning up-to-
date) or N (meaning needs upgrade).

20 |:| CMP GUI: New alarms The following minor alarms, along with the already active Critical alarms, will now be

introduced with 12.1.2 active.

Occurrence Severity = Alarm ID Text DAM VIP
Mar 12, 2015 09:22 AM EDT Minor 70501 The Cluster is running different versions of software 10.250.84.62
Mar 12, 2015 09:22 AM EDT Minor 70500 The system is running different versions of software 10.250.84.62
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Step Procedure Result

21 |:| CMP GUI: Complete the | Upgrade = Upgrade Manager
upgrade of the Primary

CMP cluster 1. Select the Primary Site 1 CMP cluster

2. Click Continue Upgrade.

NOTE: Remaining CMP

server will take i R |
approximately 40 ek initiate upgrade CMPH40H1 nead)
minutes to complete. B8 i St Faimir R

3. Click OK to continue the upgrade on the remaining server in the CMP cluster

Alarms to note:

Expected Critical Alarms

31283 Lost Communication with server
70001 QP_procmgr failed
70025 QP Slave database is a different version than the master

Expected Major Alarms

31233 HA Path Down
70004 QP Processes down for maintenance

Expected Minor Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
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Step

Procedure

Result

22 []

CMP GUI: Verify the
status of upgraded CMP
server.

Upgrade Manager - Upgrade Manager

Successful upgrade status will show the following for both servers in the Primary CMP
cluster:

e 12.1.2 inthe Running Release column for both server
e AYinthe Up to Date column
e  Active/Standby

Active alarms to note:

Expected Critical Alarms

31283 Lost Communication with server
70001 QP_procmgr failed
70025 The MYSQL Slave has a different scheme version than the master

Expected Major Alarms

31233 HA Path Down
70004 QP Processes down for maintenance

Expected Minor Alarms

31114 DB replication over SOAP has failed

31106 Database merge to parent failure

31107 Database merge from child failure

31101 Database replication to slave failure

70503 Server Forced Standby

70507 An Upgrade/Backout action on a server is in progress
70500 System Mixed Version

70501 Cluster Mixed Version

Proceed to next
upgrade procedure

Verify the following information:
Primary Site-1 is running release 12.1.2
e  Secondary Site—if applicable is on R11.5

® All C Level Nodes will be on release 11.5

®  Proceed to the next procedure if there is a Secondary CMP to upgrade. If not, skip to
section 10.

THIS PROCEDURE HAS BEEN COMPLETED
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7.1.2 Upgrade Secondary CMP Cluster

Step Procedure

Result

1 [] | cMP GuUI: Verify the
status of the CMP
cluster

Upgrade = Upgrade Manager

®  Primary CMP is completely upgraded to 12.1.2
e  Secondary CMP cluster is on 11.5

CMP GUI: Upgrade the
Secondary CMP cluster

NOTE: This will take
approximately 30
minutes to complete.

Upgrade - Upgrade Manager

NOTE: The Filter button can be used to show only the CMP servers. Enter CMP in the
Name field.

==y
e ey Pie Gmee e

o

1. Select the checkbox for the Secondary CMP Server cluster at Site-2
2. Click Start Upgrade.

w-a

o] Eu e Eerrbes 5 Reereen,

3. Click OK to confirm and continue with the operation.

The specific action taken will be determined by the Upgrade Manager and based on the
specific version change being performed.

This will continue to upgrade the standby server only in the CMP cluster.

The Upgrade Operation column shows a progress bar along with the upgrade activities.

Upgrade Operation

I

Initiate upgrade :: Upgrading server (Elapsed Time: 0:0_..

During the upgrade activities, the following alarms may be generated and considered
normal reporting events.

Expected Critical Alarms

31283 Lost Communication with server
70001 QP_procmgr failed
70025 QP Slave database is a different version than the master

Expected Major Alarm

70004 QP Processes down for maintenance

Expected Minor Database replication Alarms

70503 Server Forced Standby
70507 Upgrade In Progress

70500 System Mixed Version
70501 Cluster Mixed Version
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31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31282 HA Management Fault

LOG FILE from the GUI showing complete on the 15t server on the secondary site.

3 |:| CMP GUI: Continue to Upgrade = Upgrade Manager
upgrade the Secondary
CMP cluster

=

Select the checkbox for the Secondary CMP Server cluster at Site-2

2. Click Continue Upgrade. Notice the message ‘Failover to new version...”

Start Rollback Continue Upgrade

B | name Failover to new version CMP Site1 Cluster (next)

oo JL LR [

| =] CMP Site1 Cluster (2 Servers)

3. Click OK to confirm and continue with the operation.

The specific action will take a minute to complete. Wait until the upgraded server is
active, as shown below.

LMY ek C Rty T e

e e T AT B x il sy ymd Ty bl g %P3 Sl B

4. Select the checkbox for the Secondary CMP Server cluster at Site-2.

Click Continue Upgrade. When hovering over the button, the message will display
the next action, which is to initiate the upgrade of the remaining CMP.

Seart Rodibacs Comtrns Logress
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6. Click OK to confirm and continue with the operation.

During the upgrade activities, the following alarms may be generated and considered
normal reporting events.

Expected Critical Alarms

31283 Lost Communication with server
70001 QP_procmgr failed
70025 QP Slave database is a different version than the master

Expected Major Alarm

70004 QP Processes down for maintenance

Expected Minor Database replication Alarms

70503 Server Forced Standby
70507 Upgrade In Progress
70500 System Mixed Version
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70501 Cluster Mixed Version

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31282 HA Management Fault

CMP GULI: Verify that
the upgrade completed
successfully

Upgrade = Upgrade Manager

Successful upgrade status will show 12.1.2 in the Running Release and Upgrade Operation
columns.

CMP GUI: Verify alarm

System Wide Reports > Alarms - Active Alarms
The following Minor alarm is expected:

70500 System Mixed Version

Procedure is complete.

Verify the following information:

®  All CMP clusters upgrades are complete and running release 12.1.2.
e All MRA and MPE clusters are running release 11.5

®  The Policy Management system is running in mixed-version mode.

THIS PROCEDURE HAS BEEN COMPLETED
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8. UPGRADE CMP CLUSTERS (12.0TO 12.1.2)

This procedure will upgrade the Site-1 CMP cluster first, and if needed, upgrade the Site-2 CMP cluster in a single
maintenance window.

8.1Upgrade CMP Clusters Overview
1. Upgrade Primary CMP cluster
a. Use the CMP GUI, Upgrade - Upgrade Manager and upgrade the CMP Secondary Site 1
b. Start upgrade
c. Failover

d. Log back into the CMP GUI and upgrade the remaining Primary CMPs Force-Standby server (continue
upgrade)

2. Upgrade Secondary CMP cluster
a. Usethe CMP GUI, Upgrade = Upgrade Manager and upgrade the CMP Secondary Site 2
b. Start upgrade
c. Failover
d. Continue upgrade
This procedure should not be service affecting, but it is recommended to perform this in a Maintenance Window

It is assumed that the CMPs may be deployed as 2 georedundant clusters, identified as Site-1 and Site-2 as displayed on
the CMP GUI. When deployed as such, one site is designated as the Primary Site (which is the site that is managing the
Policy system), and the other is as Secondary Site (this site is ready to become Primary Site, if needed).

If the System is deployed with only ONE CMP, then the upgrade of the Secondary CMP can be skipped.
Identify the CMP sites to be upgraded, and verify which site is the Primary site and which site is the Secondary site:

CMP Sites Georedundant Status Operator Site Name Site Designation from Topology Form
(Site-1 or Site-2)
Primary Site

Secondary Site
Note the Information on this CMP cluster:

Cluster Name

Server-A Hostname
Server-A IP

Server-A Status

Server-B Hostname

Server-B IP Address

Server-B Status
IMPORTANT:

e CMP servers MUST be upgraded first, before the MPE or MRA clusters
e Site-1 CMP MUST be upgraded to the new release first, before the Site-2 CMP
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8.1.1 Upgrade Primary CMP Cluster

Step Procedure

Result

1 [

CMP GUI: Verify alarm
status.

System Wide Reports 2> Alarms—-> Active Alarms

1. Confirm that any existing alarm is well understood and no impact to the upgrade
procedure.

2. Capture a screenshot and save it into a file for reference.

o

CMP GUI: Identify and
record the CMP
cluster(s)

Navigate to Platform Setting=> Topology Settings = All Clusters

L ]

[r—
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1. Note which cluster is the primary and which cluster is the secondary.

The Primary CMP is noted with a P in parenthesis and a Secondary CMP is noted with
an Sin parenthesis.

2. Save a screenshot for future reference.

CMP GUI: Verify the
status of the CMP
clusters

Upgrade Manager - System Maintenance
Confirm the CMP clusters have the following:

®  Active/Standby status
®  Running release of 12.1.1 version
e  Replication ON

® Release 12.1.2 ISO files copied to at least one of each server types (CMP/MRA/MPE)—
Meaning, a copy of the MPE ISO file is on one of the MPE servers, an MRA ISO file is on
one of the MRA servers and a copy of the CMP ISO file is on one CMP server

a4 [_]| cMP GUI Access into
Primary CMP Server—
Remove old ISO files
from servers.

Upgrade Manager = I1SO Maintenance

1. Select the servers that show any of the old ISO files.

2. Select the server cluster and select Operations = Delete ISO to remove any older ISO
files that show.

| Columns o | | Filters v | | Operations v |
Push Script
Upload IS0

Click OK to continue and wait until seeing the successful deletion message

4.  Wait until the ISO Maintenance page is refreshed and the ISO column will be blank.
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CMP GUI: Distribute
ISO files to
CMP/MPE/MRA
servers

NOTE: This step
depends on the ISO
type. Distribute 1SO
files accordingly.

Upgrade Manager - ISO Maintenance

1. (Optional but preferred) Filter CMP/MPE/MRA servers
2. One application at a time, select one server type (MPE, MRA, or CMP) to be upgraded.

NOTE: The ISO files for each application type must already be copied over to at least
one server. See 4.6.3 “Distribute Application ISO Image Files to Servers” on page 24.

3. Select Operations->Upload ISO

Columns v | | Filters v | | Operations v |
Push Script
Delete ISO

4. Fill in the dialog with the following information:
Mode: Select SCP
ISO Server Hostname/IP: <IP_address_where_ISO_files_are_located>
User: admusr
Password: <admusr_password_for_the_server>

Source ISO file full path: /var/TKLC/upgrade/ <server_type_iso_filename>

5. Click Add.

When completed, the ISO column will be populated with the ISO filename and a notification

of [100%)]
: :

|
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6 [_]| CMP GUI: Verify ISO
file distribution to all
the servers

Upgrade Manager - ISO Management

e  Verify that the release 12.1.2 ISO file of the correct type is shown for each server.
e  When Completed, the ISO column is populated with the ISO filename and a notification
of [100%]

NOTE: For those servers the I1SO file was copied to from the local machine, there will not be
a 100% indicator. This indicator is only available when transferring 1SO files using the ISO
management feature.

|

7 []| SSH CLI Primary Active
CMP: exchange keys

1. Exchange keys to all servers from the Site 1 Active Primary CMP. Login as admusr user.

$sudo qpSSHKeyProv.pl --prov

NOTE: You are required to enter the PASSWORD for user admusr
2. Ensure that the Keys are exchanged successfully with all the server clusters.

$sudo qpSSHKeyProv.pl --check
EXAMPLE

Connecting to admusr@mpe-1c (10.250.zz.zz) ...

Connecting to admusr@cmp-1b (10.250.XX.XX) - .-

Connecting to admusr@mra-la (10.250.yy.y)

[13/16] Provisioning SSH keys on mra-1b (10.250.ww.w) ..
[14/16] Provisioning SSH keys on mra-la (10.250.yy.yy) ...
[15/16] Provisioning SSH keys on mpe-1c (10.250.zz.zz) ...

[16/16] Provisioning SSH keys on cmp-1b (10.250.XX.XX) ...

SSH keys are OK.
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CMP GUI: Push the
release 12.1.2 upgrade
scripts to all servers in
the segment topology

Upgrade Manager - System Maintenance

1. Select all the servers in the topology as shown.

2. Select Operations=>Push Scripts. It is safe to run the push script multiple times as

needed.
Hams e L4
; O i) Chiames
oo rmprrrhod
i SO = §an] Chate L]
¥ R ] il vy
- e L fan, I 2=
T r— - Sam 3
s e e s
e -ie it Fin
iy -t s
i fans Chasers ik
¥ HTE-LE L) £ H smrmrr 0,_32.1.5-u04_Sd 58

’ L] (* 7Y (T

5.1.5-=00_Ba s

3. Click OK to continue the operation.
Operation successful

Upgrade Command L]

Push Script

CMP234-112 IMZSET== 777 OK
MPE234-115 ILSSE T 705 DK
MPE234-116 ILSSE T 705 OK
MPE234-117 IRESETFSEITF OK
MPEZ34-126 ILSSETEE 706 0K
MRAZ234-120 0L SSE T 700 QK
MRA234-121 DR SSETE 777 DK
MRA234-148 0L SsE Tos TR DK

NOTE: Give the push script a minute to complete.

Primary Active CMP:
ssh to primary active
CMP and copy ISO file

to
/var/camiant/iso

1. Logon to the primary active CMP as admusr and copy the 12.1.2 ISO file to the

/var/camiant/iso directory.
$sudo cp -p /var/TKLC/cmp-12.1.x.iso /var/camiant/iso/

2. Verify the copy by using the following command:

$ Is /var/camiant/iso/

65 of 106

E75412-01




Software Upgrade Procedure

Step

Procedure

Result

10 [ ]

CMP GUI: Locate the
new 12.1.2 Upgrade
Manual

Upgrade = Upgrade Manager

1. Select Current ISO. In this case it is labeled Install Kit.

L e Wamags

This will open a dialog box with a description of the ISO file that was copied into the
/var/camiant/iso Directory.

2. Highlight the ISO file and click the button located in the bottom right-hand corner of
the window.

Select [50=

Sabe] vlandetdapgrads- 111 20.0_22.18 130

3. When the confirmation message appears, click OK.

Within a few seconds, the Up to Date column transitions from Y (meaning up-to-date) or N
(meaning needs upgrade).

11 [ ]

CMP GUI: Upgrade the
Primary CMP cluster

NOTE: This will take
approximately 30
minutes to complete.

Upgrade = Upgrade Manager

NOTE: The Filter button can be used to show only the CMP servers. Enter CMP in the Name
field.

o=

1. Select the checkbox for the Primary CMP Server cluster
2. Click Start Upgrade.

R el ]

o N ] e i Brvna )

3. Click OK to confirm and continue with the operation.

The specific action taken will be determined by the Upgrade Manager and based on the
specific version change being performed.

This will continue to upgrade the standby server only in the CMP cluster

In the Upgrade Operation column, it will show the Progress bar along with the upgrade
activities.

Upgrade Operation

Initiate upgrade :: Upgrading server (Elapsed Time: 0:0...

) Initiate upgrade Completed Successfully at Sep 18, 2015 14:10:18.

Upgrade Status will change to completed when done.
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During the upgrade activities, the following alarms may be generated and considered

normal reporting events.

Expected Critical Alarms

31283 Lost Communication with server
31227 HA availability status failed
70025 QP Slave database is a different version than the master

Expected Major Alarm

70004 QP Processes down for maintenance

Expected Minor Database replication Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31114 DB replication over SOAP has failed
31282 HA Management Fault

Upgrade is complete on the first CMP server in the cluster when the ‘Completed

Successfully’ message appears in the Upgrade Operation column.

12 []

CMP GUI: Verify the
upgrade is successful

Upgrade = Upgrade Manager
View the cluster.
Verify the following information:

® Oneserverison12.1.2

®  The other server in the cluster is on 12.0.

®  The Up to Date column shows Y for the 12.1.2 server and N for the 12.0 server.

OMP Sl Chmler 7 Servers]

SdP-1 L il TFO AT d Bl ITR0aE #5140

13 [ ]

CMP GUI: Continue to
upgrade CMP cluster

Upgrade = Upgrade Manager

1. Select the checkbox for the Primary CMP Server cluster

2. Click Continue Upgrade. Notice the message ‘Failover to new version...’

o e el s ]

Faiowst to new verion CWF Siw 1 Cunter jrens)

7| {UP S Chawber 0 Brreer

=c-1n W Cribo my

3. Click OK to confirm and continue with the operation.

The specific action will take a minute to complete.
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14 |:| CMP GUI: Login to the | Close the current CMP GUI browser tab and reopen another browser tab with the same
CMP server VIP CMP VIP address.

The Policy Management release 12.1.2 CMP GUI login form should appear as shown—Ilogin
and password credentials are the same as the pre-upgrade.

QRACLE

=

CMP GUI: Verify new
Policy Management
release

Navigate to Help—~>About. Verify the release number is displayed as 12.1.2.

12.1.2.0.0_22.1.0

Copyright (C) 2003, 2016 Oracle. All Rights Reserved.

CMP GUI: Critical
alarms

Critical alarm 70025, QP Slave database is a different version than the master, is seen until
the SQL Database matches the master (12.1.2). This alarm is expected and remains until all
CMP servers are upgraded to the same version.

Current Critical Alarms

N Blirers, Bormid, i gy 48 Ailarres.

Severiky  Alarm 05 Tl

4l It pET b ] Thas M35 alav

BkH WP
SRS B Y

At i LD i Ty My e bad  $Fpaed filaeen vaewwe B Uy it

e L
BN Bl L]

B L L L L e e e S S FEF- RS

Current Minor Alarms

Ak i

NOTE: The Upgrade Manager will show alarms as well.

CMP GUI: Verify the
Policy Management
release 12.1.2 CMP is

Upgrade->Upgrade Manager

Verify the following:

Active ®  Active server is 12.1.2 as indicated in the Running Release column.
e  Standby server is on the previous release.
o M e Digaiies (3 Saress
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18 [ ]

CMP GUI: Complete
the upgrade of the
Primary CMP cluster

NOTE: Remaining CMP
server will take
approximately 30
minutes to complete.

Upgrade = Upgrade Manager

1. Select the checkbox for the Primary CMP Server cluster

2. Click Continue Upgrade. Notice the message ‘Initiate upgrade...” when hovering over
the button.

Lol wuind | b

ki CLEP2AC- 110 vk =

] CMP SR Chanlar {3 bareari]

3. Click OK to continue the upgrade on the remaining server in the CMP cluster

NOTE: The server that is being upgraded will go into an OOS state.

Expected Critical Alarms

31283 Lost Communication with server
70001 QP_procmegr failed
70025 QP Slave database is a different version than the master

Expected Major Alarm

70004 QP Processes down for maintenance

Expected Minor Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31282 HA Management Fault

19 [ ]

CMP GUI: Tracking the
upgrade complete

Upgrade = Upgrade Manager

The last step in the upgrade for the first CMP cluster will be to wait for replication to
complete.

From the Upgrade Tab

CMP GUI: Verify the
status of upgraded

Upgrade Manager - Upgrade Manager

CMP server. ¥ TP e et 11 Tt
Successful upgrade status will show the following for both servers in the Primary CMP
cluster:
e 12.1.2 inthe Running Release column for both server
e AYinthe Up to Date column
®  Active or Standby state for both servers in the Primary CMP cluster.
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21 [ ]

Proceed to next
upgrade procedure

Verify the following information:

®  Primary Site-1 is running release 12.1.2
®  Secondary Site is on R12.0

Proceed to the next procedure to upgrade the secondary CMP cluster.

THIS PROCEDURE HAS BEEN COMPLETED

8.1.2 Upgrade Secondary CMP Cluster

Step

Procedure

Result

1 [

CMP GUI: Verify the
status of the CMP
cluster

Upgrade = Upgrade Manager

®  Primary CMP is completely upgraded to 12.1.2
e  Secondary CMP cluster is on 12.0

2 i el Dt [ Rerwws

T R TR S T —

CMP GUI: Upgrade
Secondary CMP cluster

NOTE: This will take
approximately 30
minutes to complete.

Upgrade = Upgrade Manager

NOTE: The Filter button can be used to show only the CMP servers. Enter CMP in the
Name field.

[ ¥ RHIFTT 1P
[T e w——

=

1. Select the checkbox for the Secondary CMP Server cluster at Site-2

2.  Click Continue Upgrade. When hovering over the button, it will read ‘Initiate
upgrade...’

o L

rabuila e AN J (has?

3. Click OK to confirm and continue with the operation.

The specific action taken will be determined by the Upgrade Manager and based on the
specific version change being performed.

This will continue to upgrade the standby server only in the CMP cluster.

In the Upgrade Operation column, it will show the Progress bar along with the upgrade
activities.

Upgrade Operation

Intiate upgrade :: Upgrading server (Elapsed Tims: 0:0...

+'!Initiate upgrade Completed Successfully at Sep 18, 2015 14:10:18.
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During the upgrade activities, the following alarms may be generated and considered
normal reporting events.

Expected Critical Alarm

31283 Lost Communication with server
70001 QP_procmgr failed
70025 QP Slave database is a different version than the master

Expected Major Alarm

70004 QP Processes down for maintenance

Expected Minor Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31282 HA Management Fault

LOG FILE from the GUI showing complete on the 1%t server on the secondary site.

<=

i 7 ]

CMP GUI: Continue
upgrade of Secondary
CMP cluster

Upgrade = Upgrade Manager

1. Select the checkbox for the Secondary CMP Server cluster at Site-2

2.  Click Continue Upgrade. When hovering over the button, it will say ‘Failover to new
version...”

Start Rollback Continue Upgrade

B |Name Failover to new version CMP Site1 Cluster (next) g

feme N I |

| = CMP Site1 Cluster (2 Servers)

3. Click OK to confirm and continue with the operation.

The specific action will take a minute to complete. Wait until the upgraded server is
active, as shown below.

L e e L e
L ¥ Bt

4. Select the checkbox for the Secondary CMP Server cluster at Site-2

Click Continue Upgrade. When hovering over the button, the message will display
the next action, which is upgrading the remaining CMP hostname

Start Rollback Continue Upgrade

= | Name Initiate upgrade CMP-3 (next) Upto

6. Click OK to confirm and continue with the operation.
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During the upgrade activities, the following alarms may be generated and considered
normal reporting events.

Expected Critical Alarm

31283 Lost Communication with server
70001 QP_procmgr failed
70025 QP Slave database is a different version than the master

Expected Major Alarm

70004 QP Processes down for maintenance

Expected Minor Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31282 HA Management Fault

CMP GULI: Verify that
the upgrade completed
successfully

Upgrade = Upgrade Manager
®  Successful upgrade status will show 12.1.2 in the Running Release and Upgrade
Operation columns.

e  Also, in the Upgrade Operation column, it will show the ‘Initiate Upgrade Completed
Successfully...” message with the correct date and time.

CMP GULI: Verify alarms

System Wide Reports = Alarms = Active Alarms

Expected Minor Alarm

70500 System Mixed Version

Procedure is complete.

Verify the following information:

e All CMP clusters upgrades are complete and running release 12.1.2.
o  All MRA and MPE clusters are running release 12.0

®  The Policy Management system is running in mixed-version mode.

THIS PROCEDURE HAS BEEN COMPLETED
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9. UPGRADE CMP CLUSTERS (12.1.1TO 12.1.2)

This procedure will upgrade the Site-1 CMP cluster first, and if needed, upgrade the Site-2 CMP cluster in a single
maintenance window.

9.1 Upgrade CMP Clusters Overview
1. Upgrade Primary CMP cluster
a. Use the CMP GUI, Upgrade - Upgrade Manager and upgrade the CMP Secondary Site 1
b. Start upgrade
c. Failover

d. Log back into the CMP GUI and upgrade the remaining Primary CMPs Force-Standby server (continue
upgrade)

2. Upgrade Secondary CMP cluster
a. Usethe CMP GUI, Upgrade = Upgrade Manager and upgrade the CMP Secondary Site 2
b. Start upgrade
c. Failover
d. Continue upgrade
This procedure should not be service affecting, but it is recommended to perform this in a Maintenance Window

It is assumed that the CMPs may be deployed as 2 georedundant clusters, identified as Site-1 and Site-2 as displayed on
the CMP GUI. When deployed as such, one site is designated as the Primary Site (which is the site that is managing the
Policy system), and the other is as Secondary Site (this site is ready to become Primary Site, if needed).

If the System is deployed with only ONE CMP, then the upgrade of the Secondary CMP can be skipped.
Identify the CMP sites to be upgraded, and verify which site is the Primary site and which site is the Secondary site:

CMP Sites Georedundant Status Operator Site Name Site Designation from Topology Form
(Site-1 or Site-2)
Primary Site

Secondary Site
Note the Information on this CMP cluster:

Cluster Name

Server-A Hostname
Server-A IP

Server-A Status

Server-B Hostname

Server-B IP Address

Server-B Status
IMPORTANT:

e CMP servers MUST be upgraded first, before the MPE or MRA clusters
e Site-1 CMP MUST be upgraded to the new release first, before the Site-2 CMP

73 of 106 E75412-01



Software

Upgrade Procedure

9.1.1 Upgrade Primary CMP Cluster

Step

Procedure

Result

1 [

CMP GUI: Verify alarm
status.

System Wide Reports 2> Alarms—-> Active Alarms

1. Confirm that any existing alarm is well understood and no impact to the upgrade
procedure.

2. Capture a screenshot and save it into a file for reference.

o

CMP GUI: Identify and
record the CMP
cluster(s)

Navigate to Platform Setting=> Topology Settings = All Clusters

ke T
[re——
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1. Note which cluster is the primary and which cluster is the secondary.

The Primary CMP is noted with a P in parenthesis and a Secondary CMP is noted with
an Sin parenthesis.

2. Save a screenshot for future reference.

CMP GUI: Verify status
of CMP clusters

Upgrade - Upgrade Manager
Confirm the CMP clusters have the following:

®  Active/Standby status
®  Running release is 12.1

e Release 12.1.2 ISO files copied to at least one of each server types (CMP/MRA/MPE)—
Meaning, a copy of the MPE ISO file is on one of the MPE servers, an MRA ISO file is on
one of the MRA servers and a copy of the CMP ISO file is on one CMP server

74 of 106

E75412-01




Software Upgrade Procedure

Step

Procedure

Result

4

L]

SSH CLI Primary Active
CMP: Exchange keys

1. Exchange keys to all servers from the Site 1 Active Primary CMP. Login as admusr user.

$sudo qpSSHKeyProv.pl --prov

NOTE: You are required to enter the PASSWORD for user admusr
2. Ensure that the Keys are exchanged successfully with all the server clusters.

$sudo qpSSHKeyProv.pl --check
EXAMPLE

Connecting to admusr@mpe-1c (10.250.zz.zz) ...

Connecting to admusr@cmp-1b (10.250.XX.XX) ...

Connecting to admusr@mra-la (10.250.yy.y)

[13/16] Provisioning SSH keys on mra-1b (10.250.ww.w) ..
[14/16] Provisioning SSH keys on mra-la (10.250.yy.yy) ...
[15/16] Provisioning SSH keys on mpe-1c (10.250.zz.zz) ...

[16/16] Provisioning SSH keys on cmp-1b (10.250.XX.XX) ...

SSH keys are OK.

CMP GUI Access into
Primary CMP Server—
Remove old ISO files
from servers.

Upgrade Manager = I1SO Maintenance

1. Select the servers that show old ISO files.

2. Select the server cluster and select Operations = Delete ISO to remove any older ISO
files that show.

ame inilpe. B e + ETE

3. Click OK to continue and wait until seeing the successful deletion message

Wait until the 1ISO Maintenance page is refreshed and the ISO column will be blank.
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6 [

CMP GUI: Distribute
ISO files to
CMP/MPE/MRA
servers

NOTE: This step
depends on the ISO
type. Distribute 1SO
files accordingly.

Upgrade Manager - ISO Maintenance

1. (Optional but preferred) Filter CMP/MPE/MRA servers
2. One application at a time, select one server type (MPE, MRA, or CMP) to be upgraded.

NOTE: The ISO files for each application type must already be copied over to at least
one server. See 4.6.3 “Distribute Application ISO Image Files to Servers” on page 24.

3. Select Operations->Upload ISO

| Columns - | | Filters v | | Operations v |
Push Script
Delate IS0

4. Fill in the dialog with the following information:
Mode: Select SCP
ISO Server Hostname/IP: <IP_address_where_ISO_files_are_located>
User: admusr
Password: <admusr_password_for_the_server>

Source ISO file full path: /var/TKLC/upgrade/ <server_type_iso_filename>

5. Click Add.

When completed, the ISO column will be populated with the ISO filename and a notification
of [100%]

CMP GUI: Verify ISO
file distribution to all
the servers

Upgrade Manager = ISO Management

e  Verify that the release 12.1.2 ISO file of the correct type is shown for each server.

e  When Completed, the ISO column is populated with the ISO filename and a notification
of [100%]

NOTE: For those servers the ISO file was copied to from the local machine, there will not be

a 100% indicator. This indicator is only available when transferring 1SO files using the ISO

management feature.
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Primary Active CMP:
ssh to primary active
CMP and copy ISO file
to
/var/camiant/iso

Logon to the primary active CMP as admusr and copy the 12.1.2 ISO file to the following
directory.

/var/camiant/iso
$sudo cp -p /var/TKLC/cmp-12.1.x.iso /var/camiant/iso/
Verify

$ Is /var/camiant/iso/

CMP GUI: Locate the
new 12.1.2 Upgrade
Manual

Upgrade = Upgrade Manager

1. Select the Current ISO. In this case it is labeled Install Kit.

gl Wi

This will open a dialog box with a description of the ISO file that was copied into the
/var/camiant/iso Directory.

2. Highlight the ISO file and click the button located in the bottom right-hand corner of
the window.

Select [50=

Sabed] dlandetd-apgrade- 110 200_22.18130

3. When the confirmation message appears, click OK.

Within a few seconds, the Up to Date column transitions from Y (meaning up-to-date) or N
(meaning needs upgrade).

CMP GUI: Upgrade the
Primary CMP cluster

NOTE: This will take
approximately 30
minutes to complete.

Upgrade = Upgrade Manager

NOTE: The Filter button can be used to show only the CMP servers. Enter CMP in the Name
field.

i aswmin LR 20
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1. Select the checkbox for the Primary CMP Server cluster
2. Click Start Upgrade.

Continu Upgtide

Irstimin upgrade CMP2.065 (e
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3. Click OK to confirm and continue with the operation.

The specific action taken will be determined by the Upgrade Manager and based on the
specific version change being performed.
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This will continue to upgrade the standby server only in the CMP cluster

In the Upgrade Operation column, it will show the Progress bar along with the upgrade
activities.

Upgrade Operation

Initiate upgrade :: Upgrading server (Elapsed Time: 0.0...

| Initiate upgrade Completed Successfully at Sep 18, 2015 14:10-18

Upgrade Operationcolumn will change to completed when done.

During the upgrade activities, the following alarms may be generated and considered
normal reporting events.

Expected Critical Alarms

31283 Lost Communication with server
31227 HA availability status failed
70025 QP Slave database is a different version than the master

Expected Major Alarm

70004 QP Processes down for maintenance

Expected Minor Database replication Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31114 DB replication over SOAP has failed
31282 HA Management Fault

Upgrade is complete on the first CMP server in the cluster when the ‘Completed
Successfully’ message appears in the Upgrade Operation column.

11 [ ]

CMP GUI: Verify the
upgrade is successful

Upgrade = Upgrade Manager
View the cluster.

Verify the following information:
® Oneserverison12.1.2

®  The other server in the cluster is on 12.1.

e  The Up to Date column shows Y for the 12.1.2 server and N for the 12.1.1server.
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Step Procedure

Result

12 [ ]| CMP GUI: Continue to
upgrade CMP cluster

Upgrade = Upgrade Manager

1. Select the checkbox for the Primary CMP Server cluster

2. Click Continue Upgrade. Notice the message ‘Failover to new version CMP Site 1’

Start Rollback  Continue Upgrade

2 |Hame Failover to new version CMP Site Cluster (next) 3
bre L B EILC

‘ EI [4 CMP site1 Cluster (2 Servers)

3. Click OK to confirm and continue with the operation.

The specific action will take a minute to complete.

13 |:| CMP GUI: Log into the
CMP server VIP

Close the current CMP GUI browser tab and reopen another browser tab with the same

CMP VIP address.

The Policy Management release 12.1.2 CMP GUI login form should appear as shown—Ilogin

and password credentials are the same as the pre-upgrade.

O<AaClL e

oo ]

14 [ ]| CMP GUI: Verify new
Policy Management
release

Navigate to Help=>About. Verify the release number is displayed as 12.1.2.

12.1.2.0.0_22.1.0

Copyright (C) 2003, 2016 Oracle. All Rights Reserved.

15 [_]| CMP GUI: Critical
alarms

Critical alarm 70025, QP Slave database is a different version than the master, will be seen
until the SQL Database matches the master (12.1.2). These alarms are expected and will

remain until all CMPs have been upgraded to the same version.

Current Critical Alarms

fhamremms Smveris  Alarm B0 Wmmi

Baw 2R 3500 G0 P EDT e Tha My B bk Sas 8 3w el e e | L
e . BELD Pkl il AR Th M, dhaen bmg u BT ened nbmes cnewar Thae e oty
g P, PR B e BT e Tt vl Wiy Bas B e RrRammY e s

B mbary A, A e 5 AR

S T, T P o naas W L ey e v o e

NOTE: The Upgrade Manager will show alarms as well.
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16 [ ]

CMP GUI: Verify the
Policy Management
release 12.1.2 CMP is
Active

Upgrade—>Upgrade Manager

Verify the following:

®  Active server is 12.1.2 as indicated in the Running Release column.

e  Standby server is on the previous release

CMP GUI: Complete
the upgrade of the
Primary CMP cluster

NOTE: Remaining CMP
server will take
approximately 30
minutes to complete.

Upgrade = Upgrade Manager

1. Select the checkbox for the Primary CMP Server cluster

2. Click Continue Upgrade. When hovering over the button, the message displays the
next action, which is to initiate the upgrade of the remaining CMP.

St Rolbach Dot Upgrads

rabiad e upgrache TRIFS -1 jreat |

¥ CMP e Chusier (1 Sarvess

3. Click OK to continue the upgrade on the remaining server in the CMP cluster

NOTE: Server getting upgraded will go O0S

Expected Critical Alarms

31283 Lost Communication with server
70001 QP_procmgr failed
70025 QP Slave database is a different version than the master

Expected Major Alarm

70004 QP Processes down for maintenance

Expected Minor Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31282 HA Management Fault

CMP GUI: Tracking the
upgrade complete

Upgrade = Upgrade Manager

The last step in the upgrade for the first CMP cluster will be to wait for replication to
complete.

From the Upgrade tab:
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19 [ ]

CMP GUI: Verify the
status of upgraded
CMP server.

Upgrade = Upgrade Manager
Successful upgrade status will show the following for the servers in the Primary CMP cluster:
® 12.1.2 inthe Running Release column for both server

® AYinthe Up to Date column
®  Active/Standby

Proceed to next
upgrade procedure

Verify the following information:

®  Primary Site-1 is running release 12.1.2
®  Secondary Site is on R12.1

Proceed to the next procedure to upgrade the secondary CMP cluster.

THIS PROCEDURE HAS BEEN COMPLETED

9.1.2 Upgrade Secondary CMP Cluster

Step

Procedure

Result

1

L]

CMP GUI: Verify the
status of the CMP
cluster

Upgrade = Upgrade Manager

®  Primary CMP is completely upgraded to 12.1.2
e  Secondary CMP cluster is on 12.1

[1 = T LTy,

WP R Dt o e

2 |:| CMP GUI: Upgrade the Upgrade = Upgrade Manager
S dary CMP clust
econdary cluster NOTE: The Filter button can be used to show only the CMP servers. Enter CMP in the
NOTE: This will take Name field.
approximately 30 P T
minutes to complete. e e e =
i
1. Select the checkbox for the Secondary CMP Server cluster at Site-2
2. Click Start Upgrade
Corainun Upgrads
e ritiarin upgrade CREEE08 inaut)
= I OWe Sied Clesiar {7 Servars]
CMP2.35 i
CME23E L Mmar ¥
[ CMP SRed Clmler {2 Servars)
3. Click OK to confirm and continue with the operation.
The specific action taken will be determined by the Upgrade Manager and based on the
specific version change being performed.
This will continue to upgrade the standby server only in the CMP cluster.
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The Upgrade Operation column shows a progress bar along with the upgrade activities.

Upgrade Operation

[Step 2/3] 0% Initiate upgrade - Upgrading server (Elapsed Time: 0:0..-

+) Inttiate upgrade Completed Successfully at Sep 18, 2015 14:10:18.

During the upgrade activities, the following alarms may be generated and considered
normal reporting events.

Expected Critical Alarm

31283 Lost Communication with server
70001 QP_procmgr failed
70025 QP Slave database is a different version than the master

Expected Major Alarm

70004 QP Processes down for maintenance

Expected Minor Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31282 HA Management Fault

LOG FILE from the GUI showing complete on the 1%t server on the secondary site.

3 |:| CMP GUI: Continue to Upgrade = Upgrade Manager
upgrade the Secondary

1. Select the checkbox for the Secondary CMP Server cluster at Site-2
CMP cluster

2.  Click Continue Upgrade. When hovering over the button, it will say ‘Failover to new
version...”

Start Rollback  Continue Upgrade

E | Name Failover to new version CMP Site1 Cluster (next) p.
SN || N 1 | Y o [

‘ ) ] CMP site1 Cluster (2 Servers)

3. Click OK to confirm and continue with the operation.

This action takes some time to complete. Wait until the upgraded server is active, as
shown below.

4. Select the checkbox for the Secondary CMP Server cluster at Site-2

Click Continue Upgrade. When hovering over the button, the message will display
the next action, which is upgrading the remaining CMP hostname.
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6. Click OK to confirm and continue with the operation.

During the upgrade activities, the following alarms may be generated and considered
normal reporting events.

Expected Critical Alarm

31283 Lost Communication with server
70001 QP_procmgr failed
70025 QP Slave database is a different version than the master

Expected Major Alarm

70004 QP Processes down for maintenance

Expected Minor Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31282 HA Management Fault

4 |:| CMP GULI: Verify that Upgrade = Upgrade Manager
the upgrade is

successful. ®  Successful upgrade status will show 12.1.2 in the Running Release and Upgrade

Operation columns.

® Inthe Upgrade Operation column, the message ‘Initiate Upgrade Completed
Successfully...” with the correct date and time is shown.

5 |:| CMP GUI: Verify alarms | System Wide Reports > Alarms > Active Alarms

Expected Minor Alarm
70500 System Mixed Version

6 |:| Procedure is complete. Verify the following information:

®  All CMP clusters upgrades are complete and running release 12.1.2.
e  All MRA and MPE clusters are running release 12.1.1

®  The Policy Management system is running in mixed-version mode.

THIS PROCEDURE HAS BEEN COMPLETED
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10. MPE AND MRA UPGRADE
The following procedures will upgrade a site/segment containing one or more MPE clusters, and MRA clusters.
NOTES:

e Anupgrade of up to 4 clusters can be running at the same time.

e MPE and MRA clusters can be upgraded at the same time.
10.1 Site/Segment Upgrade Preparation

10.1.1 Configuration Preparation

Step Procedure Result
1 |:| CMP GUI: Access into CMP Use a supported browser to login using the admin user ID or with a user ID that has
server admin privileges.
2 |:| CMP GUI: Verify current Upgrade = Upgrade Manager

Upgrade Manager status
and software release 12.1.2

ISO files e  Verify that all MPE and MRA clusters have both Active, Standby.

e  Verify that all CMP clusters have both Active, Standby status.

e  Verify that Policy Management release 12.1.2 ISO files are available for all CMP,
MPE and MRA clusters. One ISO file per server

e  Verify that the CMP cluster is upgraded successfully and running Policy
Management release 12.1.2

THIS PROCEDURE HAS BEEN COMPLETED
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10.2 Upgrade MRA and MPE Servers
This procedure will upgrade one or more clusters (MPE and/or MRA) at a site/segment.
This procedure is applicable for a 10.5, 11.5, 12.0, or 12.1.1 upgrade to 12.1.2

This section can be replicated for each site/segment to be upgraded, allowing you to add cluster and site specific
information.

The upgrade procedure is essentially the same for an MRA cluster and an MPE cluster.

1. Select and start upgrade on Standby server
2. Failover one cluster at a time
3. Re-apply configuration one cluster at a time
4. Continue upgrade on remaining server
5. (MPE only) Re-apply configuration one MPE cluster at a time
NOTES:
e All CMP clusters must be upgraded to Policy Management release 12.1.2 prior to executing the following
procedures.
e  Four (4) clusters can be running the upgrade at one time.
e Only ONE cluster can be selected for upgrade activity, bulk selection of servers is not supported in release
12.1.2
Step Procedure Result
1 [] | cMPGUI: Health Perform the following:

Checks on the

MPE/MRA servers to be
upgraded 2. Reset MPE/MRA counters to make a baseline

1. Check for current Active Alarms

- For the MPE: Policy server-> Configuration><server_name>->Reports 2>
Reset Counters

- For the MRA: MRA- Configuration=><server_name>->Reports > Reset
Counters

3. Go to the KPI Dashboard and capture a screenshot.
System Wide Reports 2> KPI Dashboard
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Step Procedure Result

2 |:| CMP GUI: Verify the Upgrade - Upgrade Manager
upgrade status of
selected MPE/MRA

site/segment e  Current release 10.5, 11.5, 12.0, or 12.1.1 installed

Verify information for the MRAs/MPEs:

®  Active/Standby status
®  |SO version to be deployed is 12.1.2
e  Verify the current ISO files are 12.1.2 using UPGRADE->ISO Maintenance
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3 |:| CMP GUI: Upgrade NOTE: Start the upgrade on ONE cluster. Wait for a minute, and then continue with the
clusters next cluster and so on. Up to 4 clusters maximum may be running upgrade at any one

time.
NOTE: 4 clusters can be

running the upgrade Upgrade = Upgrade Manager

rocess at one time.
P 1. Select the checkbox for the cluster (one cluster at a time) (can be an MRA or MPE)

NOTE: The upgrade of a | 5
single server takes
approximately40 L—
minutes to complete.

Click Continue Upgrade.

MPE T v L]
= [ MPEX) |2 Servers)

WFE2&0-54 L Bectirit

NP3 42-00 (i H Aty

3. Click OK to confirm and continue with the operation. It will begin to upgrade the
standby Server of that cluster.

Wait until the cluster reports OOS before selecting the next cluster

Follow the progress in the Upgrade Operation column.

Upgrade Operation

Initiate upgrade - Upgrading server (Elapsed Time: 0:0.

) Inttiate upgrade Completed Successfully at Sep 18, 2015 14:10:18.

During the upgrade activities, the following alarms may be generated and considered
normal reporting events—these will be cleared after the MPE cluster is completely
upgraded.

Expected Critical Alarms

31283 Lost Communication with server
70001 QP_procmegr failed
31227 HA availability status failed

Expected Major Alarms

70004 QP Processes down for maintenance
31233 HA Path Down
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Step Procedure Result

Expected Minor Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31282 HA Management Fault

78001 Rsync Failed

Upgrade is complete on the first server in the cluster when the ‘Completed Successfully...’
message shows in the Upgrade Operation column. The server will go back to Standby
state when the upgrade completes.

— % EEAIRRIT TR G A T

During the upgrade activities, the following alarms may be generated and considered
normal reporting events.

The following minor alarms may be present:

Expected Minor Alarms

78001 Rsync Failed

70500 System Mixed Version
70501 Cluster Mixed Version
70503 Server Forced Standby

4 |:| CMP GUI: Continue to Fail over ONE cluster at a time and wait until the upgraded server becomes active before
upgrade the MRA/MPE moving on to the next cluster.

clusters. Next operation
is a failover Upgrade = Upgrade Manager

NOTE: 4 clusters can be 1. Select the checkbox for the cluster (one cluster at a time) (can be an MRA or MPE)

running the upgrade 2. Click Continue Upgrade. When hovering over the button, it will say ‘Failover to new
process at one time. version...”

Start Rollback  Continue Upgrade

g | Mame Failover to new version MPE33 (next) s.pvermole Prev Release

=[] CMP Site1 Cluster (2 Servers)

3. Click OK to confirm and continue with the operation. It will begin to failover the
cluster.

Wait until failover completes before failing over the next cluster. And verify the 12.1.2
server is now active. Complete is when there is an active/standby

o WAL T Rmean sl

v TR TR, S— w—
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Step Procedure Result

5 |:| CMP GUI: Reapply For MPE: PolicyServer = Configuration 2 <MPE_cluster_name> -> System
configuration on the
MPE/MRA cluster that
failed over successfully. | The selected cluster will show different releases for the Active and Standby servers with
Config mismatch. This is expected.

For MRA: MRA-> Configuration><MRA_cluster>->System

1. Select Operations=>Reapply Configuration.

NOTE: A Progress bar appears for the MPE reapply configuration and NOT the MRA
reapply configuration

- appbyiig STl G e B

Apphyiieg Ciafeguratean 10 Poliy S8redr 18 108 B8 -

2. Note the version is successfully changed to the release 12.1.2

NOTE: The status still shows as Degraded. This is a normal reporting event as the servers
are in different releases.

[ M Reporls | Logs | Policy Sarver | Dlamwber Hoaldng | Polickes | Data Souwnces | Session Viewer
Moty | Defete | Reapply Conflguration
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6 |:| CMP GUI: Current During the upgrade activities, the following alarms may be generated and considered
alarms normal reporting events.

Expected Critical Alarm

None

Expected Major Alarm

None

Expected Minor Alarms

70503 Server Forced Standby

70502 Cluster Replication Inhibited

70500 System Mixed Version

70501 Cluster Mixed Version

71402 Connectivity Lost

78001 Rsync Failed

31101 Database replication to slave failure
31113 DB replication manually disabled

7 |:| CMP GUI: If traffic does | Upgrade Manager = System Maintenance
not become active

within 90 seconds If traffic is active, go to step 9.

e  Select the checkbox for the partially upgraded cluster, and click Start Rollback.

® Release 10.5,11.5,12.0, or 12.1.1 MPE server should become active and resume
handling traffic.
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Result

s [

CMP GUI: Reapply the
configuration back to
release 10.5, 11.5,12.0,
orl12.1.1

1. Policy Server - Configuration > <mpe_cluster name> - System tab
or
MRA - Configuration > <mpe_cluster name> > System tab

2. Click Reapply Configuration

e  Verify that the version is changed from 12.1.2 to 10.5, 11.5, 12.0, or 12.1.1, and the
action report success.

e If NOT, contact Oracle support to consider backout of the partially upgraded cluster.

CMP GUI: Continue the
upgrade of MRA/MPE
clusters. Next operation
is initiate upgrade on
the Standby server

NOTE: 4 clusters can be
running the upgrade
process at one time.

Continue The upgrade on ONE cluster at a time and when the server goes into O0S,
continue with the next cluster and so on. Up to 4 clusters may be running upgrade at one
time.

Upgrade = Upgrade Manager

1. Select the checkbox for the cluster
- Select one cluster at a time
- Can be an either an MRA or MPE cluster

2. Click Continue Upgrade. When hovering over the button, it will read ‘Initiate
upgrade...’

3. Click OK to confirm and continue with the operation. It will begin the final server
upgrade of the cluster

Wait until the cluster reports OOS before selecting the next cluster

Follow the progress status in the Upgrade Operation column.

Upgrade Operation

Initiate upgrade :: Upgrading server (Elapsed Time: 0:0...

/) Initiate: upgrade Completed Successfully at Sep 18, 2015 14:10:18

During the upgrade activities, the following alarms may be generated and considered
normal reporting events—these will be cleared after the MPE cluster is completely
upgraded.

Expected Critical Alarms

31283 Lost Communication with server
31227 HA availability status failed
70001 QP_procmegr failed

Expected Major Alarm

70004 QP Processes down for maintenance

Expected Minor Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

78001 Rsync Failed

70502 Cluster Replication Inhibited

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
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Result

31107 Database merge from child failure

31101 Database replication to slave failure
31102 Database replication from master failure
31113 DB replication manually disabled

Upgrade is complete when the following is observed:

®  The completed successfully message is in the Upgrade Operation column.
e  The server goes back to the Standby state.

e  The Up to Date column shows a Y (YES).

Output of a successful upgrade showing the MPE cluster on release 12.1.2

= MPL Sl Chalerd {7 Servery

=oe-14 gy

-3 L e At 1000 014 Lrakl ol

Possible Minor Alarms

78001 Rsync Failed
70500 System Mixed Version

CMP GUI: (MPEonly)
Reapply configuration
on the MPE cluster that
completed the upgrade
successfully.

MPE only

4. PolicyServer = Configuration = <MPE_cluster_name> = System
5. Select Operations—=> Reapply Configuration
NOTE: A progress bar appears for the MPE reapply configuration.

R appbying SeTlings b the B

Apphying Confaguratesn 1o Policy Sarver -58 Fe 5e

11 [ ]

Repeat steps 1-9 for
the next MPE or MRA
clusters

Proceed with next cluster(s):
MPE Cluster
MPE Cluster

MPE Cluster

MPE Cluster
MRA Cluster __

NOTE: If you are using Veritas NetBackup there are additional steps to perform after an
upgrade. See the Maintenance Operation Procedure (MOP) for the Netbackup.

12 []

ACCEPT UPGRADE
REQUIREMENT

For release 12.1.2, the Accept Upgrade step is not required. It will be embedded as part
of the next release upgrade procedure.

THIS PROCEDURE HAS BEEN COMPLETED
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11. POST UPGRADE HEALTH CHECK

NOTE: This section is used when the entire topology is running release 12.1.2

Step Procedure Result

1 |:| CMP GUI: Verify the Upgrade = Upgrade Manager
upgrade is successful on View the Ub to Date. Running Rel qU 4e O i |
all CMP/MRA/MPE iew the Up to Date, Running Release, and Upgrade Operation columns
clusters.

2 |:| CMP GUI: View current Navigate to System Wide Reports=> Alarms—>Active Alarms
alarms . .

Only Possible alarms are the following.

3 |:| CMP GULI: View current Navigate to System Wide Reports=>KPI Dashbord
KPIs

4 |:| CMP GUI: View trending Navigate to System Wide Reports=> Trending Reports
reports

5 |:| CMP GUI: Replication Navigate to System Wide Reports=> Others=> MPE/MRA Rep Stats
stats

THIS PROCEDURE HAS BEEN COMPLETED
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12. BACKOUT (ROLLBACK)

This procedure is executed if an issue is found during the upgrade, as well as post-upgrade which impacts network
performance.

The Policy system will be backed out to the previous release.

Oracle strongly recommends consulting Technical Services and Escalation team before initiating the backout procedure.
They will determine the appropriate course of recovery options.

12.1 Backout Sequence
The backout sequence order is the reverse of the upgrade order as in the following sequence :
1. Backout MRA/MPE: Use Upgrade Manager
2. Backout the Secondary CMP cluster (if applicable): Use Upgrade Manager
3. Backout the Primary CMP cluster:
o For 10.5 and 11.5, use Upgrade Manager and System Maintenance Manager.
0 For12.0 and 12.1.1backout, use Upgrade Manager for all components.

During a backout, it is important to control what version of the software is currently active. This control needs to be
maintained even if there are unexpected failures.

NOTE: In the case of an MPE/MRA, the upgrade/backout is NOT complete until the operator does a Reapply
Configuration operation from the CMP. The MRA/MPE can still operate, but may not be fully functional.

12.2 Pre-requisites
1. No new policies or features have been configured or executed on the upgraded release.

2. The CMP cluster cannot be backed out if other Policy servers (MPEs and MRAS) are still on the upgraded
release.

NOTE: If Veritas NetBackup is being used on a 10.5 Policy Management system, see the Maintenance Operation
Procedure for additional backout steps.

12.3 Backout of Fully Upgraded Cluster

Prior to executing this procedure, Oracle recommends first consulting the Technical Services team, to discuss the next
appropriate course of actions.

This procedure is used to backout a cluster that has been fully upgraded. At the end of this procedure, all servers of the
target cluster will be on release 10.5, 11.5, 12.0, or 12.1.1 (MRA, MPE, CMP) with Active, Standby status.

Expected pre-conditions:
1. Primary Active CMP is on release 12.1.2
2. Cluster is of MPE, MRA or CMP
3. One server of target cluster is on release 12.1.2 in Active role
4

One server of target cluster is on release 12.1.2 in either Standby or Force Standby

12.3.1 Backout Sequence

This procedure applies to an Active/Standby group of servers. This group of servers will be referred to as a cluster or
HA cluster. The cluster types are CMP, MRA or MPE. For CMP cluster, the cluster status may also be Site-1 and/or
Site-2.
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12.3.1.1 Required Cluster Backout Sequence (Reverse of the Upgrade Sequence)
1. MRAs and MPEs—Site 1 and Site-2 clusters—Uses current Upgrade Manager
2. CMP Site-2 cluster (if applicable)—Uses current Upgrade Manager

3. CMP Site-1 cluster—Uses current Upgrade Manager and System Maintenance for 10.5 or11.5, and the
Upgrade Manager only for 12.0 or 12.1

NOTE: It is possible, and desirable, to backout multiple clusters in parallel. However, in order to do this, you must
click one cluster at a time, staggering by 1 minute each.

12.3.1.2 Overview on Backout/Rollback MRA/MPE cluster

NOTE: The following procedure should be used to backout a 12.1.2 cluster to Policy 10.5, 11.5, 12.0, or 12.1.1.
This will preserve the cluster as a GR MRA cluster.

Use the CMP GUI (Upgrade Manager) to begin the backout of the MRA/MPE cluster

Wait until complete

Use the CMP GUI (Upgrade Manager) to continue the backout of the MRA/MPE cluster

Failover

Reapply the configuration

Use the CMP GUI (Upgrade Manager) to continue the backout of the MRA/MPE cluster

o g w DR

12.3.1.3 Backout Secondary CMP (If Applicable)
At this time, all MPEs and MRAs must already be backed out.
Use the CMP GUI (Upgrade Manager) to backout the Secondary CMP cluster

12.3.1.4 Backout Primary CMP (10.5)

NOTE: Secondary CMP must already be backed out and all of the MPE/MRA clusters
1. Use the CMP GUI (Upgrade Manager) to backout the Primary standby CMP cluster
2. Log back in to the Primary CMP VIP
3. Use the 10.5 System Maintenance to complete backout of the Primary CMP cluster

12.3.1.5 Backout Primary CMP (11.5)

NOTE: Secondary CMP must already be backed out and all of the MPE/MRA clusters
1. Use the CMP GUI (Upgrade Manager) to backout the Primary standby CMP cluster
2. Log back in to the Primary CMP VIP
3. Use the 11.5 System Maintenance to complete backout of the Primary CMP cluster

12.3.1.6 Backout Primary CMP (12.0 and 12.1.1)
Use the CMP GUI (Upgrade Manager) to backout the CMP cluster.

12.3.2 Backout of a Partially Upgraded Cluster

A partially upgraded cluster occurs when the version is not correct or the success message does not appear. If this
happens, contact Oracle Support and report a partially upgraded cluster.
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12.3.3 Backout Fully Upgraded MPE/MRA Cluster

NOTE: If you are using Veritas NetBackup there are additional steps to perform before a backput. See the Maintenance
Operation Procedure (MOP) for Netbackup.

Step Procedure Result

1 |:| CMP GUI: Verify the status Upgrade Manager - Upgrade Manager

of affected clusters
Confirm status of the cluster to be backed out:

®  Primary Active CMP is on release 12.1.2
e  All Standby servers are on release 12.1.2

e  Up to Date column shows Y for all servers
EXAMPLE

BT e Cheter) L beerain

2 |:| CMP GULI: Rollback standby | Select the upgraded clusters to backout.

MPE/MRA clust
/ clusters Upgrade > Upgrade Manager

NOTE: The backout of a

. 1. Select the checkbox for the cluster.
single server takes

approximately 40 minutes - Select one cluster at a time.
to complete. - Can be an MRA or MPE cluster.
NOTE: Up to 4 clusters can 2. Click Start Rollback. When hovering over the button, it will inform you of the
be backed out at the same server to backout, in this case it will be the current standby server.
t!me, selecting one at a T e
time.
Initiate Backout mpe-gh-mpe-1a (Back) | s ey ol Peew Relaase

[l cMe Sited Clusier i Servers)

CMp=pli=CTE=4 ¥ Standby M.500.0_35.10.0 121208 221

[ -]

ore—pi-cmp-b I Wner v itive MER00_381
[ Pt Siled Clustar [7 Servers)

- . Sdandey 5800 3858 1208 3840

meg-me- 1k B Mings Aciie niano 3o TArZee 2R

3. Click OK to confirm and continue with the operation. It will begin to backout. The
server will show OOS in the Server Role column.

Follow the progress status in the Upgrade Operation column.

Upgrade QOperation

Initiate upgrade :: Upgrading =erver (Elapsed Time: 0:0...

+") Initiate upgrade Completed Successfully at Sep 18, 2015 14:10:18.

The server backing out will go into OOS state. Wait until the server goes to an 00S
state before selecting the next cluster to backout.

During the upgrade activities, the following alarms may be generated and considered
normal reporting events. These will be cleared after the cluster is completely backed
out.

94 of 106 E75412-01



Software Upgrade Procedure

Step Procedure Result

Expected Critical Alarms

31283 Lost Communication with server
31227 HA availability status failed
70001 QP_procmegr failed

Expected Major Alarms

70004 QP Processes down for maintenance
31233 HA Path Down

Expected Minor Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

78001 Rsync Failed

70502 Cluster Replication Inhibited

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31102 Database replication from master failure
31113 DB replication manually disabled
31282 HA Management Fault

Backout of the server is complete when the ‘Initial backout Completed Successfully...”
shows in the Upgrade Operation column. The server will show running release of 10.5,
11.5,12.0, or 12.1.1 and return to standby

w3 i e e vl i g 5 31 bR E

3 |:| CMP GUI: Continue the Select the partially backed out cluster to backout.
backout of the MRA/MPE
clusters. Next operation is
failover to the 10.5, 11.5, 1. Select the checkbox for the cluster.
12.0, or 12.1.1 server.

Upgrade = Upgrade Manager

- Select one cluster at a time.

NOTE: Up to 4 clusters can - Can be an MRA or MPE cluster.

tte backed 9“t at the same 2. Click Continue Rollback. When hovering over the button, it will inform you to
:!me, selecting one at a failover to old version.

ime.

sy Sotann B Uy

Fiboss bn ot vermeny WPE Bte ) Comien fhmch]

M L awims

3. Click OK to confirm and continue with the operation. It will begin to failover the
cluster.

Wait until the server fails over before selecting the next cluster. This will take a
minute or two.

Follow the progress in the Server Role column. The Server will show OOS in the server
role until the backout completes. Wait for the server to show Standby in the Server
role column.
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Step Procedure Result

During the backout activities, the following alarms may be generated and considered
normal reporting events—these will be cleared after the cluster is completely backed
out.

Expected Critical Alarms

31283 Lost Communication with server
31227 HA availability status failed
70001 QP_procmegr failed

Expected Major Alarms

70004 QP Processes down for maintenance
31233 HA Path Down
31126 Audit blocked

Expected Minor Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

78001 Rsync Failed

70502 Cluster Replication Inhibited

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31102 Database replication from master failure
31113 DB replication manually disabled
31282 HA Management Fault

4 |:| CMP GUI: Reapply the For MPE: PolicyServer - Configuration 2 <MPE cluster name> - System
configuration to the

MPE/MRA cluster that
completed the failover The selected cluster will have the status of Degraded. This is expected
successfully.

For MRA: MRA-> Configuration=><MRA cluster>=>System

1. Click Reapply Configuration.
- The MPE opens a dialog box showing the progress of the reapply process.
- The MRA will not show anything.

2. Note the version is successfully changed to the previous release. The following
figure shows 11.5

@ Reports | Logs | Policy ServerT Diameter Routing T Policies T Data Sources T Session Viewer]

Modify | Delste | Reapply Configuration

The configuration was applied successfully.
Configuration

Name MPE Sitel Cluster1
Status

Version 11.5.0

Description / Location

Secure Connection No

Legacy No

Type Oracle

System Time Oct 01, 2015 09:28 AM EDT

Associated Templates(lower numbered templates take priority over higher numbered templates)

Priority Template Name

None

NOTE: The status still showing Degraded is a normal reporting event because the
servers currently have different releases.
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Step

Procedure

Result

5 [

CMP GUI: Complete
backout of cluster(s)

NOTE: The backout of a
single server takes
approximately 35 minutes
to complete.

NOTE: Up to 4 clusters can
be backed out at the same
time, selecting one at a
time.

1. Select the partially Backed out cluster

Upgrade = Upgrade Manager

2. Select the checkbox for the cluster (one cluster at a time) (can be an MRA or
MPE)

3. Click Continue Rollback. When hovering over the button, it will inform you of the
server to get backed out.

e e sy P 0w Al

s g e e

4. Click OK to confirm and continue with the operation. It will begin to backout.

Follow the progress status in the Upgrade Operation column.

Upgrade Operation

Initiate upgrade :: Upgrading server (Elapsed Time: 0.0...

! Initiate upgrade Completed Successfully at Sep 18, 2015 14:10:18

During the upgrade activities, the following alarms may be generated and considered
normal reporting events. These will be cleared after the cluster is completely backed
out.

Expected Critical Alarms

31283 Lost Communication with server
31227 HA availability status failed
70001 QP_procmegr failed

Expected Major Alarms

70004 QP Processes down for maintenance
31233 HA Path Down
31126 Audit blocked

Expected Minor Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

78001 Rsync Failed

70502 Cluster Replication Inhibited

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31102 Database replication from master failure
31113 DB replication manually disabled
31282 HA Management Fault

Backout of the server is complete when the message ‘Initiate backout Completed
Successfully...” shows in the Upgrade Operation column. All of the servers will be on
the previous release and show active/standby.
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Step Procedure Result
6 |:| Repeat this Procedure for remainder of MPE/MRA servers, if not fully backed out yet.
7 |:| Final Syscheck Another Syscheck on all the backed out servers, can be performed to ensure all
modules are still operationally OK before progressing to the next Procedure.

THIS PROCEDURE HAS BEEN COMPLETED

12.3.4 Backout Fully Upgraded Secondary CMP Cluster

NOTE: The Secondary CMP Site-2 cluster to be backed out first using the Upgrade Manager—followed by the Primary CMP Site-
1 cluster using both the upgrade Manager and the 10.5/11.5 System Maintenance option. For Rollback to R12.0 and 12.1, the
Upgrade Manager is used.

Step Procedure Result
1 |:| CMP GUI: Verify the Upgrade Manager = System Maintenance
tat f the CMP
status ot the Confirm status of the cluster to be backed out.
clusters
®  Primary Active CMP is on release 12.1.2
e  Standby servers are on release 12.1.2
e  Up to Date column shows Y for all servers
NOTE: The Filter button can be used to show only the CMP servers. Enter CMP in the
Name field.
EXAMPLE
oo ek UL 2
i
2 [_]| ¢cMP GUI: backout 1. Select Secondary CMP cluster to backout.

secondary CMP cluster Upgrade - Upgrade Manager

NOTE: The backoutofa | 5 select the checkbox for the Secondary CMP cluster
single server takes

approximately 40
minutes to complete.

3. Click Start Rollback. When hovering over the button, it will inform you of the server
to get backed out.

Start Rollback Start Upgrade

| Initiate backout CMP244-11 (back) 1,5 ypt | ServerRe

cip [ B LA

=

4. Click OK to confirm and continue with the operation. It will begin to backout. The
server will show OOS in the Server Role column.

Follow the progress in the Upgrade Operation column.

Upgrade Operation

Initiate upgrade :: Upgrading server (Elapsed Time: 0:0...

+"! Initiate upgrade Completed Successfully at Sep 18, 2015 14;10:18.

During the upgrade activities, the following alarms may be generated and considered
normal reporting events. These will be cleared after the cluster is completely backed out.
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NOTE: The Secondary CMP Site-2 cluster to be backed out first using the Upgrade Manager—followed by the Primary CMP Site-
1 cluster using both the upgrade Manager and the 10.5/11.5 System Maintenance option. For Rollback to R12.0 and 12.1, the
Upgrade Manager is used.

Step Procedure Result

Expected Critical Alarms

31283 Lost Communication with server
31227 HA availability status failed
70001 QP_procmegr failed

Expected Major Alarm

70004 QP Processes down for maintenance
31233 HA Path Down
31126 Audit blocked

Expected Minor Alarms

70503 Server Forced Standby
70507 Upgrade In Progress
70500 System Mixed Version
70501 Cluster Mixed Version
78001 Rsync Failed
70502 Cluster Replication Inhibited
31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31102 Database replication from master failure
31113 DB replication manually disabled
31282 HA Management Fault
Backout of the server is complete when the ‘Initiate backout Completed Successfully...”

message shows in the Upgrade Operation column. The server will go back to standby state
and show the previous release

3 [ ]| CMPGUI: Continuethe | 1. Select Secondary CMP cluster.
backout. Next

Upgrade = Upgrade Manager
operation is failover.

2. Select the checkbox for the Secondary CMP cluster

3. Click Continue Upgrade. When hovering over the button, it will say ‘Failover to new
version...”

4. Click OK to confirm and continue with the operation. It will begin to failover the
cluster.

Wait until the previous release becomes active before continuing.

Expected Critical Alarm

70025 QP Slave database is a different version than the master

Expected Minor Alarms

70503 Server Forced Standby
70501 Cluster Mixed Version
78001 Rsync Failed

70500 System Mixed Version
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NOTE: The Secondary CMP Site-2 cluster to be backed out first using the Upgrade Manager—followed by the Primary CMP Site-

1 cluster using both the upgrade Manager and the 10.5/11.5 System Maintenance option. For Rollback to R12.0 and 12.1, the
Upgrade Manager is used.

Step Procedure Result
a4 [ || cMPGuUI: Continuethe | 1.  Select Secondary CMP cluster.
backout. Next
operation is initiate
backout 2. Select the checkbox for the Secondary CMP cluster

Upgrade = Upgrade Manager

3. Click Continue Rollback. When hovering over the button, it will inform you to rollback

Conltims: Rolback  Resums Wpprade

Initiate backoun CMP245-17 (back] 40 ca

4. Click OK to confirm and continue with the operation. It will begin to failover the
cluster.

Follow the progress in the Server Role column.

Expected Critical Alarm

70025 QP Slave database is a different version than the master

Expected Minor Alarm

70500 System Mixed Version

THIS PROCEDURE HAS BEEN COMPLETED
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12.3.5 Backout Fully Upgraded Primary CMP Cluster

NOTE: The Secondary CMP Site-2 cluster to be backed out first using the Upgrade Manager—followed by the Primary CMP
Site-1 cluster. For R10.5 or 11.5, use both the Upgrade Manager and System Maintenance. For rollback to R12.0 or 12.1, only

use the Upgrade Manager.

Step

Procedure

Result

1 [

CMP GUI: Verify the
status of the CMP
clusters

Upgrade Manager = System Maintenance
Confirm status of the cluster to be backed out:

®  Primary Active CMP is on release 12.1.2
®  Secondary CMP cluster is on release 10.5,11.5, 12.0, or 12.1.1

e  Up to Date column shows Y for all servers in Primary CMP cluster

NOTE: The Filter button can be used to show only the CMP servers. Enter CMP in the
Name field.

[T
Py ey PP Gmew s e

-

CMP GUI: backout
standby Primary CMP
cluster

NOTE: Backout of one
server will take
approximately 40
minutes to complete.

Select the Primary CMP cluster to backout.
Upgrade = Upgrade Manager

1. Select the checkbox for the Primary CMP cluster

2.  Click Start Rollback. When hovering over the button, it will inform you of the server
to get backed out, in this case it will be the current standby server.
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3. Click OK to confirm and continue with the operation. It will begin to backout. The
server will go into an OOS server Role

Follow the progress of the status in the Upgrade Operation column.

Upgrade Operation

Intiate upgrade - Upgrading server (Elapsed Time: 0:0..

) Initiate upgrade Completed Successfully at Sep 18, 2015 14:10:18.

During the upgrade activities, the following alarms may be generated and considered
normal reporting events. These will be cleared after the cluster is completely backed out.
Expected Critical Alarms

31283 Lost Communication with server
31227 HA availability status failed
70001 QP_procmgr failed

31236 HA Link Down

Expected Major Alarm

70004 QP Processes down for maintenance
31233 HA Path Down

Expected Minor Alarms

31114 DB replication over SOAP has failed
31106 Database merge to parent failure

101 of 106

E75412-01



Software Upgrade Procedure

NOTE: The Secondary CMP Site-2 cluster to be backed out first using the Upgrade Manager—followed by the Primary CMP
Site-1 cluster. For R10.5 or 11.5, use both the Upgrade Manager and System Maintenance. For rollback to R12.0 or 12.1, only
use the Upgrade Manager.

Step Procedure Result

31107 Database merge from child failure

31101 Database replication to slave failure
31102 Database replication from master failure
31113 DB replication manually disabled

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

78001 Rsync Failed

70502 Cluster Replication Inhibited

Backout of the server is complete when the message ‘Initiate backout Completed
Successfully...” shows in the Upgrade Operation column. The server will go back to
standby state and show the previous release.

B k] i e
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3 [ ]| cMP GuI: Continue the | 1. Select Primary CMP cluster.
backout. Next

Upgrade = Upgrade Manager
operation is failover

2. Select the checkbox for the Secondary CMP cluster

3. Click Continue Rollback. When hovering over the button, it will say ‘Failover to old
version...”

o CMP e Chambe (T Sarven
w1011

A1 1 o ]

4. Click OK to confirm and continue with the operation. It will begin to failover the
cluster.

Failover takes a couple minutes.

4 |:| CMP GUI: Log back in After failover, you will be required to log back in to the CMP GUI using the Primary CMP

to the Primary CMP VIP.
VIP
ORACLE
|
5 |:| CMP GULI: Verify Navigate to Help>About. Verify the release number is displayed as 10.5, 11.5, 12.0, or
release 12.1.1.

e  [f Rollback is for release 10.5 or 11.5, continue with step 6.

e If Rollback is for release 12.0 or 12.1, continue with step 8
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Software Upgrade Procedure

NOTE: The Secondary CMP Site-2 cluster to be backed out first using the Upgrade Manager—followed by the Primary CMP
Site-1 cluster. For R10.5 or 11.5, use both the Upgrade Manager and System Maintenance. For rollback to R12.0 or 12.1, only

use the Upgrade Manager.

Step

Procedure

Result

6 []

CMP GUI (release 10.5
or 11.5): Continue the

backout of the Primary
CMP cluster

NOTE: Backout of one
server will take
approximately 30
minutes to complete.

Upgrade - System Maintenance
1.

Select the checkbox for the remaining server in the Primary CMP cluster. The server
will be on 12.1.2 and show Forced Standby
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2.

3.

Follow the progress in the Upgrade Status column. Wait until the server to backout comes
to backout complete.

During the upgrade activities, the following alarms may be generated and considered
normal reporting events. These will be cleared after the cluster is completely backed out.

Select Operations—>Backout

Click OK to continue

Expected Critical Alarms

31283 Lost Communication with server

Expected Major Alarm

31233 HA Path Down
31236 HA Link Down
70004 QP Processes down for maintenance

Expected Minor Alarms

31114 DB replication over SOAP has failed

31106 Database merge to parent failure

31107 Database merge from child failure

31101 Database replication to slave failure
31102 Database replication from master failure
31113 DB replication manually disabled

31284 HA Remote Subscriber Heartbeat Warning
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https://100.64.181.62/infocenter/topic/m_cpm_troubleshooting/tasks/t_cpm_comcol_alarm_31114.html?resultof=%22%33%31%31%31%34%22%20
https://100.64.181.62/infocenter/topic/m_cpm_troubleshooting/tasks/t_cpm_comcol_alarm_31106.html?resultof=%22%33%31%31%30%36%22%20
https://100.64.181.62/infocenter/topic/m_cpm_troubleshooting/tasks/t_cpm_comcol_alarm_31107.html?resultof=%22%33%31%31%30%37%22%20
https://100.64.181.62/infocenter/topic/m_cpm_troubleshooting/tasks/t_cpm_comcol_alarm_31101.html?resultof=%22%33%31%31%30%31%22%20

Software Upgrade Procedure

NOTE: The Secondary CMP Site-2 cluster to be backed out first using the Upgrade Manager—followed by the Primary CMP
Site-1 cluster. For R10.5 or 11.5, use both the Upgrade Manager and System Maintenance. For rollback to R12.0 or 12.1, only
use the Upgrade Manager.

Step

Procedure

Result

7 [

CMP GUI: Remove
Forced standby

Upgrade 2> System Maintenance

1. Select the checkbox for the remaining server in the Primary CMP cluster. The server
will be on 10.5 or 11.5 and show Forced Standby
NOTE: A refresh of the current screen may be necessary at the 40 minute mark.

2. Select Operations=>Cancel Forced Standby

By
Malaans

e e T T—

The backout procedure is now completed for releases 10.5 or 11.5. Go to step 9 and
perform the final Syscheck.

CMP GUI (release 12.0
or 12.1): Continue the

backout of the Primary
CMP cluster

NOTE: Backout of one
server will take
approximately 40
minutes to complete.

1. Select Primary CMP cluster to complete the backout.

Upgrade = Upgrade Manager

1. Select the checkbox for the Primary CMP cluster

2.  Click Start Rollback. When hovering over the button, it will inform you of the server
to back out. In this case, it will be the current standby server.

o ommirasy Bolingcs Bovgme Sray pde
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3. Click OK to confirm and continue with the operation. It will begin to backout. The
server will go into an OOS server Role

Follow the progress in the Upgrade Operation column.

Upgrade Operation

Initiate upgrade :: Upgrading server (Elapsed Time: 0:0...

) Initiate upgrade Completed Successfull at Sep 18, 2015 14:10:18

During the upgrade activities, the following alarms may be generated and considered
normal reporting events. These will be cleared after the cluster is completely backed out.

Expected Critical Alarms

31283 Lost Communication with server
31227 HA availability status failed
70001 QP_procmgr failed

Expected Major Alarm

70004 QP Processes down for maintenance

Expected Minor Alarms

70503 Server Forced Standby
70507 Upgrade In Progress
70500 System Mixed Version
70501 Cluster Mixed Version
78001 Rsync Failed
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https://100.64.181.62/infocenter/topic/m_cpm_troubleshooting/tasks/t_cpm_alarm_70004.html?resultof=%22%37%30%30%30%34%22%20
https://100.64.181.62/infocenter/topic/m_cpm_troubleshooting/tasks/t_cpm_alarm_70503.html?resultof=%22%37%30%35%30%33%22%20
https://100.64.181.62/infocenter/topic/m_cpm_troubleshooting/tasks/t_cpm_alarm_70507.html?resultof=%22%37%30%35%30%37%22%20
https://100.64.181.62/infocenter/topic/m_cpm_troubleshooting/tasks/t_cpm_alarm_70500.html?resultof=%22%37%30%35%30%30%22%20
https://100.64.181.62/infocenter/topic/m_cpm_troubleshooting/tasks/t_cpm_alarm_70501.html?resultof=%22%37%30%35%30%31%22%20

Software Upgrade Procedure

NOTE: The Secondary CMP Site-2 cluster to be backed out first using the Upgrade Manager—followed by the Primary CMP
Site-1 cluster. For R10.5 or 11.5, use both the Upgrade Manager and System Maintenance. For rollback to R12.0 or 12.1, only

use the Upgrade Manager.

Step

Procedure

Result

70502 Cluster Replication Inhibited

31114 DB replication over SOAP has failed
31106 Database merge to parent failure

31107 Database merge from child failure

31101 Database replication to slave failure
31102 Database replication from master failure
31113 DB replication manually disabled

Backout of the server is complete when the message ‘Initiate backout Completed
Successfully...” shows in the Upgrade Operation column. The server will go back to
standby state and show the previous release

9 [_]] Final Syscheck

A Syscheck on all the backed out servers, can be performed to ensure all modules are still
operationally OK before progressing to the next Procedure.

THIS PROCEDURE HAS BEEN COMPLETED
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https://100.64.181.62/infocenter/topic/m_cpm_troubleshooting/tasks/t_cpm_alarm_70502.html?resultof=%22%37%30%35%30%32%22%20
https://100.64.181.62/infocenter/topic/m_cpm_troubleshooting/tasks/t_cpm_comcol_alarm_31114.html?resultof=%22%33%31%31%31%34%22%20
https://100.64.181.62/infocenter/topic/m_cpm_troubleshooting/tasks/t_cpm_comcol_alarm_31106.html?resultof=%22%33%31%31%30%36%22%20
https://100.64.181.62/infocenter/topic/m_cpm_troubleshooting/tasks/t_cpm_comcol_alarm_31107.html?resultof=%22%33%31%31%30%37%22%20
https://100.64.181.62/infocenter/topic/m_cpm_troubleshooting/tasks/t_cpm_comcol_alarm_31101.html?resultof=%22%33%31%31%30%31%22%20

Software Upgrade Procedure

APPENDIX A. ACCESSING THE ORACLE CUSTOMER SUPPORT SITE AND
HOTLINES

Access to the Oracle Customer Support site is restricted to current Oracle customers only. This section describes how to
log into the Oracle Customer Support site and link to Oracle Support Hotlines

1. Loginto the Oracle Customer Support site at https://support.oracle.com
2.

Refer Oracle Support Hotlines http://www.oracle.com/us/support/contact/index.html and
http://www.oracle.com/us/corporate/acquisitions/tekelec/support/index.html
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